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1 Introduction 

1.1 About this Document 
This document is the Jiffy Manual. It describes how to set up and manage your café 
with the Jiffy Internet Café Manager software. 
 
A copy of this documentation is available to you when you install the Jiffy Application 
Server and may be viewed online with a web browser using the Jiffy Web Console. 
 

 

1.2 About Jiffy 
Jiffy is a client/server based system and so is made up of two components – the Jiffy 
Application Server and the Jiffy Client. 
 
The Jiffy Application Server is written in the Java programming language and thus has 
the potential for running on most operating systems – Microsoft Windows, Linux and 
other flavours of Unix including Apple’s Mac OS. The Jiffy Client runs on Microsoft 
Windows 2000/XP. 
 
Unlike other Internet Café Management software applications, Jiffy does not provide a 
standalone Graphical User Interface (GUI) that you need to install for carrying out café 
management tasks. Instead, what you get is a powerful and intuitive web-based 
interface called the Jiffy Web Console that you can access from anywhere, anytime (on 
your Local Area Network – LAN – or via the Internet) using a web browser. This 
interface can be accessed once you have installed the Jiffy Application Server. 
 
Note:  

• You should not install both the Jiffy Application Server and Jiffy Client on the 
same computer except for evaluation purposes. 

 
 

1.2.1 Understanding Jiffy Version Numbers 
The Jiffy Application Server and Jiffy Client have version numbers that describe each 
release. The version numbers are in the following format: x.y.z, where x refers to the 
Release version number, y the Major version number and z the Minor version number. 
 
The Release version number indicates the version number of the release. A higher 
Release version number signifies that the new release contains additional or 
significantly enhanced features not available in the previous release. 
 
A higher Major version number signifies that previously available features may function 
differently in the new release. New features may not be added. 
 
A higher Minor version number indicates that minor bugs detected in a previous 
release have been fixed. New features are not added. 
 

1.2.2 Matching Jiffy Releases 
It is important to use the correct version of Jiffy Client with the correct version of the 
Jiffy Application Server. Using the following rules, you can determine which version of 
Jiffy Client is appropriate for a particular version of the Jiffy Application Server: 
 
1 Release version numbers must match – for instance Jiffy Client v1.1.0 must be 

used with v1.1.0 of the Jiffy Application Server and not with v2.0, for instance. 
 
2 Major version numbers must match – for instance Jiffy Client v1.1.0 must be used 

with v1.1.0 of the Jiffy Application Server and not with v1.2.0, for instance. 
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3 Minor version numbers do not need to match – for instance Jiffy Client v1.1.1 may 
be used with v1.1.2 of the Jiffy Application Server. 

 
 

1.3 System Requirements 

1.3.1 Jiffy Application Server 

• Processor: 
Intel Pentium III 700 MHz or its equivalent (Minimum) 
Intel Pentium IV 1.4GHz (or higher) or its equivalent (Recommended) 

• Operating System: 
Windows 2000 Professional or Server with (Service Pack 4), Windows XP 
or Windows Server 2003.  

• Memory: 
128MB (Minimum) 
256MB or more (Recommended).  

• Java Runtime Environment (JRE): 
Java 2 Standard Edition (J2SE 1.5/5.0) or higher which, you can download free 
of charge from http://java.sun.com/j2se/1.5.0/download.html. The Jiffy 
Application Server will not run on previous versions of the JRE. (Note: you do 
not require the Java Development Kit, the JRE is sufficient.) 

• Web Browser: 
Internet Explorer 6, Mozilla Firefox 1.0 (or higher), Netscape Navigator 7.0, Safari. 
 

 

1.3.2 Jiffy Client 
The Jiffy Client is not written in Java and so does not require the Java Runtime 
Environment. 

• Processor: 
Intel Celeron/Pentium II or higher (or its equivalent)  

• Operating System: 
Windows 2000 Professional, Windows XP.  

• Memory: 
64MB (Minimum) 
128MB or more (Recommended). 

 

 

1.4 Installing Jiffy 

1.4.1 Jiffy Application Server 
 
1.4.1.1 Installing the Jiffy Application Server 
The first step is to download and install the J2SE Runtime Environment from: 
http://java.sun.com/j2se/1.5.0/download.html. The installation instructions can be 
found here: http://java.sun.com/j2se/1.5.0/install.html.  
 
After installing the JRE, run the Jiffy Application Server installation program: jiffy-
appserverx.x-setup.exe. Provide the necessary information whenever the wizard 
prompts you to do so. 
 
Important: When asked to provide the HTTP/1.1 Web Console Port, you may leave 
the default value of '8080' as the port number. This port is used to access the Jiffy 
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Web Console with a web browser via a URL like this: 
http://hostname:port number (e.g. http://localhost:8080). This port number must be 
unique and available which means that no other application must have registered it for 
its own use. 
Note:  

• You can change it to any other value (typically between 0 and 65535). 
However, if you do not wish to include the port number in the URL, set the port 
number to '80', but be sure that no other application, e.g. another Web Server 
or Proxy Server is using it. 

 
• For the Jiffy Server Port, you may also leave the default value of '5555' as the 

port number or you may change it to another value. The Jiffy Client stations use 
this port to connect to the Jiffy Server. The same rules that apply to the 
HTTP/1.1 Web Console Port also apply to Jiffy Server Port. 

 
When you are done with the Jiffy Application Server installation wizard, open Microsoft 
Windows' Services Control Manager: Control Panel > Administrative Tools > Services. 
Locate and select the service called 'Jiffy Application Server', right-click on it and 
choose 'Start' from the context menu. Or you can simply open a command prompt 
window and enter: net start “Jiffy Application Server” at the prompt. 
If the service successfully starts, then all went well and you are in business! If not, 
refer to the Troubleshooting FAQs section of this document for help. 
 
After starting the service, enter the following URL in your web browser's address field: 
http://hostname:port number/setup to begin with the web-based setup and to get 
your site ready for use. Where hostname refers to name or IP Address of the Jiffy 
Application Server host machine and port number is the port number you chose for the 
HTTP/1.1 Web Console Port. If you are accessing the Jiffy Web Console from within 
your Local Area Network (LAN), then the computer's hostname will do but if you are 
coming in via the Internet, you must provide a publicly identifiable IP Address as the 
hostname. 
 
When the web-based setup page opens, enter your company information as requested. 
You would also have to create the site's Administrator's account. Provide a user name 
e.g. 'admin' or some other name for this account and enter its password and confirm 
it. Please choose a strong password that cannot be easily guessed. 
 
When you are done, click the Finish button to continue or you may wish to do so at 
some other time by entering http://hostname:port number in your browser. You would 
be prompted to log in. Enter the Administrator account user name and password you 
had created earlier, as this would be the only user account available at this stage. 
 
 

1.4.2 Jiffy Client 
 
1.4.2.1 Installing Jiffy Client 
To install the Jiffy Client software on any of your computers, simply run its installation 
program: jiffy-clientx.x-setup.exe. Provide the necessary information whenever the 
wizard prompts you to do so. 
 
Important: When asked to provide the Jiffy Server name, enter the hostname of the 
machine that the Jiffy Application Server is running on. You may provide its IP Address 
instead, but it is advisable to provide its hostname as this would ensure that you do 
not have to reconfigure your Jiffy Client stations each time the Server's IP Address 
changes. 
 
For the Jiffy Server Port, you may leave the default value of '5555' as the port number 
if you did not specify a different value when you installed the Jiffy Application Server. If 
you did, enter the correct value, otherwise, the Jiffy Client stations will not be able to 
connect to the Jiffy Server. 
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1.4.2.2 Understanding Print Monitoring and Billing 
Jiffy offers you the ability to monitor your printers and bill/charge your customers for 
print jobs sent to them in two different ways: Client-based and Server-based Print 
Monitoring and Billing.  
Print Monitoring, in the Client-based scenario, is carried out on the client stations; 
while in the Server-based scenario, it is done on the Jiffy Server. Please refer to 
section 5.3.1.3 for additional information on this. 
  
You can monitor printers installed in the following ways: 
 
1. Printers directly attached (via the LPT or USB port, for instance) to other computers 

on your network (including the Jiffy Server machine) and shared; e.g. Printer A and 
Printer B connected to Computer A and Computer B respectively, or Printer A 
connected to Computer A and Printer B connected to the Jiffy Server machine. 
These other computers may have Jiffy Client installed and running on them. In this 
scenario, you must employ Client-based Print Monitoring and Billing. After installing 
and sharing your printers on the respective computers, you must install the print 
drivers on all other computers that have Jiffy Client installed as described in section 
1.4.2.3 below. 

 
2. Printers directly attached (via the LPT or USB port, for instance) to the Jiffy Server 

machine and shared; e.g. Printer A and Printer B both connected to the Jiffy Server 
Machine. In this scenario, you may employ either Client-based or Server-based 
Print Monitoring and Billing. After installing and sharing your printers on the Jiffy 
Server machine, you may install the print drivers on the Jiffy Client stations as 
described in either section 1.4.2.3 or 1.4.2.4 below. 

 
3. Printers directly attached to the network via a TCP/IP-based print server device or 

interface. In this scenario, you must employ Client-based Print Monitoring and 
Billing. For details on how to install print drivers for use with your print server, 
please follow the instructions in its documentation.  

 
 
1.4.2.3 Installing Print Drivers for Client-based Print Monitoring and Billing 
This section describes how to install your printers’ drivers for Print Monitoring and 
Billing on each of your computers before or after you have installed Jiffy Client in a 
Client-based scenario as described in section 1.4.2.2 above.  
 
After installing your printers and sharing them on their respective machines, to install 
the print drivers on your Jiffy Client stations, start Microsoft Windows’ Add Printer 
Wizard: Control Panel > Printers > Add Printer. Click Next. You will be prompted to 
specify either a Local Printer or Network Printer.  
 
• Installing a Local Printer 
The term Local Printer does not necessarily mean that the printer is directly attached 
to the PC on which you are currently installing the print drivers. The printer may 
actually be connected to another machine on the network and shared. Note that only a 
Microsoft Windows user account with Administrative rights on the PC can install a 
printer in this manner. The advantage of installing the print drivers like this is that the 
computer on which the printer is installed and shared does not have to be on before 
each Jiffy Client station starts up and initialises Print Monitoring and Billing. Also, the 
printer is available to any user who logs on to the PC. However, this is not very secure 
as users, with or without Administrative privileges, may install network printers for 
themselves while Jiffy Client is running, completely bypassing the print monitor. You 
can prevent this by defining a policy to prohibit the addition of printers.  
 
If the printer is directly attached to the PC, select the appropriate port but if it is not 
(which would be the case if, for instance, you are installing a printer that is shared on 
another PC on the network), uncheck the Automatically detect and install my Plug and 
Play printer checkbox. Click Next. 
 
In the ‘Select the Printer Port’ dialogue box, select Create a new port. If you are 
connecting to a printer that is shared on another PC on the network, select Local Port. 
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Click Next. In the ‘Port Name’ dialogue box enter the following: \\computer 
name\printer share name and click Okay, where computer name refers to name of the 
computer on which the printer you wish to connect to is shared and printer share name 
refers to the name the printer is shared as. Click Next to continue. Select the 
manufacturer and model of your printer from the list of available printers or provide a 
disk that contains the driver that you would like to install and complete the ‘Add Printer 
Wizard’.  
 
• Installing a Network Printer 
A Network Printer is a printer installed on another PC on the network and shared. The 
advantage of installing the print drivers like this is that print monitoring is more secure 
as users without Administrative privileges will not be able to install network printers 
that you have already installed while Jiffy Client is running. However to ensure secure 
print monitoring on each PC, you need to install network printers for each Microsoft 
Windows user account on that PC (especially the user account with which Jiffy Client 
logs into Windows). Also, the PCs on which the printers are installed and shared should 
have the same Microsoft Windows user accounts (same user name and password) as 
the other Jiffy Client stations and must finish loading Microsoft Windows before all 
other Jiffy Client stations start up and initialise Print Monitoring and Billing. 
 
To install a Network Printer, select Network Printer and Click Next. Locate the desired 
printer on your network and complete the ‘Add Printer Wizard’. 
 
 
1.4.2.4 Installing Print Drivers for Server-based Print Monitoring and Billing 
This section describes how to install your printers’ drivers for Print Monitoring and 
Billing on each of your computers before or after you have installed Jiffy Client in a 
Server-based scenario as described in section 1.4.2.2 above.  
 
After installing your printers and sharing them on the Jiffy Server machine, to begin 
monitoring your printers immediately, start the Jiffy Application Server service if it is 
not running or restart it, if it is already running.  
 
To install the print drivers on your Jiffy Client stations, use any of the two methods 
described in section 1.4.2.3 above.  
 
Note: 

• The preferred way of running Jiffy Client on all your stations is to provide a 
Microsoft Windows user account for Jiffy to log in to Windows with. For easier 
management, it is recommended that you use the same user name and 
password when you create this user account on each station (Jiffy can 
automatically create the account for you). To ensure that users can print from 
each station, you should create an account with the same user name and 
password on the PCs where the printers are installed and shared. 

 
• It is important that you opt to replace any previous print drivers if you are 

prompted. 
 
• If you are connecting to a printer directly attached to the network via a TCP/IP-

based print server device, select Standard TCP/IP Port in the ‘Select the Printer 
Port’ dialogue box and provide the needed information to complete the 
installation of your printer according to the device manufacturer’s 
documentation.  

 
• After installing your printer, open its properties dialogue box. In the ‘Advanced’ 

tab ensure that the option Spool print documents so program finishes printing 
faster is selected. If Print directly to the printer is selected and Print Monitoring 
and Billing is enabled, the computer will hang if someone attempts to send a 
print job to the printer while Jiffy Client or Jiffy Server is running. 

 
• After installing your printers on all your stations and ascertaining that Print 

Monitoring and Billing is working properly, to ensure that users cannot add or 
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delete printers on your stations, you may define (in addition to others) the 
following two security policy settings: 

 
1. Disable deletion of printers 
 
2. Disable addition of printers 

Refer to section 5.3.1.1 in Chapter 5 of this document to see how to define a 
security policy for your Jiffy Client stations. 

 

1.5 Uninstalling Jiffy 

1.5.1 Jiffy Application Server 
If the Jiffy Application Server is running, you must stop the ‘Jiffy Application Server’ 
service to be able to completely uninstall it and remove all its files. 
 
To stop the ‘Jiffy Application Server’ service, do one of the following: 
 
1. Open Microsoft Windows' Services Control Manager: Control Panel > Administrative 

Tools > Services. Locate and select the service called Jiffy Application Server, right-
click on it and choose 'Stop' from the context menu.  

 
2. Open a command prompt window and enter: net stop “Jiffy Application Server” at 

the prompt. 
 
 
1.5.1.1 Uninstalling the Jiffy Application Server Without Losing Data 
After you have stopped the ‘Jiffy Application Server’ service, to uninstall the Jiffy 
Application Server without losing valuable data (especially if you are performing an 
upgrade or a reinstallation), do the following: 
   

o Using Windows Explorer, browse to the location <HOME>\webapps\ROOT\WEB-
INF\classes – where <HOME> refers to the directory where you installed the 
Jiffy Application Server, e.g. C:\Program Files\Jiffy Application Server. Copy the 
two files jiffy_server.properties and app.info to a temporary location. (In order 
to retain your old configuration after the upgrade or reinstallation, you will have 
to put these files back in the same location).  

 
o Browse to the location <HOME>\webapps\ROOT\WEB-INF\data. Copy the folder 

jiffydb and its entire content to a temporary location. This folder contains your 
data. 

 
o After that, to uninstall the Jiffy Application Server, do one of the following: 

 
1. Using Windows Explorer, browse to the location where you installed the Jiffy 

Application Server, e.g. C:\Program Files\Jiffy Application Server. Double-
click the program file, uninstall-jiffyappserver.exe. Confirm the action by 
clicking the ‘Uninstall’ button. 

 
2. Open Control Panel in Windows and double-click Add/Remove Programs. 

From the list of the currently installed programs, select Jiffy Application 
Server and click the ‘Change/Remove’ button. Confirm the action by clicking 
the ‘Uninstall’ button. 

 
After reinstalling the Jiffy Application Server and if you need to restore your old 
configuration and data, do the following: 
 

o Browse to the temporary location where you put the two files 
jiffy_server.properties and app.info. Copy these files and place them in the 
location <HOME>\webapps\ROOT\WEB-INF\classes. When asked if you want to 
replace an existing file with another, answer Yes. 
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o Browse to the temporary location where you put the folder jiffydb. Copy this 
folder and its entire content to the location <HOME>\webapps\ROOT\WEB-
INF\data. When asked if you want to replace the existing folder and its files with 
the folder you are copying, answer Yes to All. 

 
o Start the ‘Jiffy Application Server’ service in the usual manner and check to 

make sure that your data is intact. A quick way to ensure that you did not lose 
data is to attempt to log in to the Jiffy Web Console. After you have done that 
successfully, also check to make sure that your old configuration settings are in 
effect. 

 
o If all goes well, delete the jiffydb folder and the two files jiffy_server.properties 

and app.info from the temporary locations where you put them. 
 
 
1.5.1.2 Uninstalling the Jiffy Application Server Completely 
After you have stopped the ‘Jiffy Application Server’ service, to completely uninstall the 
Jiffy Application Server do one of the following: 
 
1. Using Windows Explorer, browse to the location where you installed the Jiffy 

Application Server, e.g. C:\Program Files\Jiffy Application Server. Double-click the 
program file, uninstall-jiffyappserver.exe. Confirm the action by clicking the 
‘Uninstall’ button. 
 

2. Open Control Panel in Windows and double-click Add/Remove Programs. From the 
list of the currently installed programs, select Jiffy Application Server and click the 
‘Change/Remove’ button. Confirm the action by clicking the ‘Uninstall’ button. 

 
 

1.5.2 Jiffy Client 
 
1.5.2.1 Uninstalling Jiffy Client 
If Jiffy Client is running, you must stop it to be able to completely uninstall it and 
remove all its files.  
 
To stop Jiffy Client, log in to the station as Station Manager and click the ‘Stop Jiffy’ 
button in the Station Management Console. After that, to uninstall Jiffy Client, do one 
of the following: 
 
1. Using Windows Explorer, browse to the location where you installed Jiffy Client, 

e.g. C:\Program Files\Jiffy. Double-click the program file, uninstall-jiffy.exe. 
Confirm the action by clicking the ‘Uninstall’ button. 

 
2. Open Control Panel in Windows and double-click Add/Remove Programs. From the 

list of the currently installed programs, select Jiffy Client and click the 
‘Change/Remove’ button. Confirm the action by clicking the ‘Uninstall’ button. 

 
 

1.6 Downloading and Applying Jiffy Updates 
Starting with version 1.3.0 of both the Jiffy Application Server and Jiffy Client, you can 
update your versions of these software components to the latest versions whenever 
updates are available. 
 
These updates enable you to, unless otherwise specified, upgrade your version of Jiffy 
to the latest version without having to first of all uninstall (and reinstall) either the 
client or server component of Jiffy. They can be applied even while Jiffy Client or the 
Jiffy Application Server is running on the target computers – the changes will take 
effect when the computers are rebooted. 
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Note: 
• You must have at least version 1.3.0 of the Jiffy Application Server and Jiffy 

Client respectively to be able to apply any Jiffy updates. 
 
 

1.6.1 Updating the Jiffy Application Server 
 
1.6.1.1 Downloading the latest update of the Jiffy Application Server  
To download the latest update of the Jiffy Application Server, in the Web Console tree 
panel, click the ‘Setup’ branch to expand it. Click the ‘Updates’ leaf to expose the ‘Jiffy 
Software Updates’ panel. Click ‘Download’ in the ‘Application Server’ menu. 
 
If there are any updates available, download the latest one (if you have not already 
downloaded and installed it before) and save it to an appropriate location on the Jiffy 
Application Server computer (or your network, where it can be easily accessed from 
the server).  
 
 
1.6.1.2 Installing the latest update of the Jiffy Application Server  
Any downloaded updates of the Jiffy Application Server must be run on the target 
computer on which the Jiffy Application Server has been properly installed.  
 
To run the Jiffy Application Server update program: jiffy-appserver-updatex.x.exe, 
double-click the file in Windows Explorer. The update will run successfully if it is 
applicable to your current version of the Jiffy Application Server. You will be prompted 
to reboot the target computer so that the changes can take effect. You may want to 
ensure that there are no active customers or users on any of your stations before 
accepting to reboot the server machine. 
 
Note: 

• The update will not be applied if the currently installed version of the Jiffy 
Application Server is the same as (or newer than) the version of the update you 
are attempting to apply. 

 

 

1.6.2 Updating Jiffy Client 
 
1.6.2.1 Downloading the latest update of Jiffy Client 
To download the latest update of Jiffy Client, in the Web Console tree panel, click the 
‘Setup’ branch to expand it. Click the ‘Updates’ leaf to expose the ‘Jiffy Software 
Updates’ panel. Click ‘Download’ in the ‘Client’ menu. 
 
If there are any updates available, download the latest one (if you have not already 
downloaded and applied it before on all your stations) and save it to the following 
location on the Jiffy Application Server computer:  
 
<HOME>\webapps\ROOT\updates\client – where <HOME> refers to the directory 
where you installed the Jiffy Application Server, e.g. C:\Program Files\Jiffy Application 
Server. Make sure that you place all Jiffy Client updates in this directory so that the 
Jiffy Client stations can find the relevant update when you attempt to apply or install it 
as described in sections 1.6.2.2 and 1.6.2.3 below.  
 
Note: 

• Also ensure that only Jiffy Client updates are placed in this directory. No other 
files should be placed in this directory. 
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1.6.2.2 Applying the latest update of Jiffy Client on all connected stations 
Jiffy offers you the ability to easily update all the stations currently connected to the 
server at once.  
To be able to apply downloaded Jiffy Client updates on all connected stations, you 
must log in with an account that has the ‘Download and Apply Jiffy Updates’ 
permission. 
 
To apply the latest downloaded update on all the connected stations, in the Web 
Console tree panel, click the ‘Setup’ branch to expand it. Click the ‘Updates’ leaf to 
expose the ‘Jiffy Software Updates’ panel. Click ‘Apply’ in the ‘Client’ menu. The 
currently connected stations will attempt to download the latest update from client 
update directory on the Jiffy Application Server computer and execute it. The version 
of Jiffy Client running on the stations will be updated if the downloaded update is 
applicable and the stations will be automatically rebooted as a result.  
 
Note: 

• The update will not be applied if the currently installed version of Jiffy Client is 
the same as (or newer than) the version of the update you are attempting to 
apply. 

 
• You may want to ensure that there are no active customers or users on any of 

your stations before applying any Jiffy Client updates as these stations will be 
rebooted if the updates are applicable.  

 
• If you have successfully applied an update of Jiffy Client on all your stations, 

you may delete the update from the client update directory on the Jiffy 
Application Server computer if it is no longer needed. 

 
 
1.6.2.3 Applying the latest update of Jiffy Client on specific stations 
You can also apply Jiffy Client updates on specific stations.  
 
To be able to apply downloaded Jiffy Client updates on specific stations, you must log 
in with an account that has both the ‘Station Management’ and ‘Download and Apply 
Jiffy Updates’ permissions. 
 
To apply the latest downloaded update on a specific station, in the Jiffy Web Console 
tree, click the ‘Tools’ branch to expand it. Click the ‘Jiffy Clients’ leaf to display its 
menus and then click Active Stations in the ‘View’ menu. 
 
Select the station whose version of Jiffy Client you wish to update from the list of 
active stations in the ‘Jiffy Stations’ window and click the ‘System Info’ button. In the 
‘Jiffy Client System Information’ dialogue box, click the ‘Apply Update’ button. The 
station will attempt to download the latest update from client update directory on the 
Jiffy Application Server computer and execute it. The version of Jiffy Client running on 
the station will be updated if the downloaded update is applicable and the station will 
be automatically rebooted as a result.  
 
Note: 

• The update will not be applied if the currently installed version of Jiffy Client is 
the same as (or newer than) the version of the update you are attempting to 
apply. 

 
• You may want to ensure that there is no active customer or user on the station 

before applying any Jiffy Client updates as the station will be rebooted if the 
updates are applicable.  

 
• If you have successfully applied an update of Jiffy Client on all your stations, 

you may delete the update from the client update directory on the Jiffy 
Application Server computer if it is no longer needed. 
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2 Getting Started 

2.1 Jiffy Features and Benefits 

2.1.1 Monitoring and Management Features 
• Jiffy Application Server starts automatically as a service upon system start up – 

no need to manually start it. 
• Connect to your café from anywhere, anytime using just a web-browser 
• Manage multiple sites remotely from a single location 
• Generate, activate and print customer tickets in batches or on-demand using a 

suitable POS printer 
• Create and manage password-protected customer accounts 
• Permanent view of all computers and their status 
• See (and close) all applications – window title and program file name – opened 

by users on all computers. 
• Shutdown/Restart one or more computers 
• Lock/Unlock one or more computers 
• Send messages to currently logged-on customers 
• Bill customers who bring their own laptops or PCs using the Jiffy Web Client 

feature 
• Monitor and bill/charge for printing activity 
• Schedule automatic database backups 
• Backup/Restore database 
• Remove old data to trim the size of the database 

2.1.2 Billing Features 
• Various categories of customer tickets with different monetary values and rates 
• Create customer accounts with different rates as well as employee accounts 
• Special day/night-time rates e.g. Happy Hour, weekly rates e.g. every Sunday, 

monthly rates e.g. the 1st day of every month, yearly rates e.g. every Dec. 25. 
• Special rates for different computers 
• Usage Rules for additional restrictions on ticket/account usage 

2.1.3 Customer Loyalty Feature (Optional) 
• Points awarded to customer account holders for positive payments made into 

their accounts 
• Redemption of loyalty points (free additional units) upon loyalty realisation. 

2.1.4 Security Features 
 
Jiffy Application Server:  

• The database is encrypted and passwords are stored as hashed text 
• Employee accounts can be created and granted a set of permissions (over 

twenty-five of them) either in groups or individually.  
• Fully audited employee activity to ascertain who did what and when it was done  

 
Jiffy Client stations: 

• Lock-station feature – station is locked upon customer reaching the number of 
consecutive unsuccessful login attempts (optional) 

• Automatically start Microsoft Windows with any given Microsoft Windows’ user 
account (by default a user account with ‘User’ privileges is created by Jiffy) to 
enforce the security settings of that particular user account. 

• Apply and enforce specific Windows’ policies 
• Allow only specific programs to run 

2.1.5 Reports and Logs 
• Generate/View reports and logs 
• Comprehensive report and log filtering options – by date, Ticket ID, Account ID, 

station, etc 
• Subscribe to and receive specific reports via e-mail on schedule 
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• Schedule the sending of account status reports to account holders via e-mail 
• Create and save reports so as not to lose important data when you delete old 

data 
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3 How Jiffy Works 
Jiffy has been designed from ground up to provide reliable and easy to use monitoring, 
billing and management features for Internet café operations. Jiffy operates in a 
client/server scenario and thus requires the client component (simply called Jiffy 
Client) to be installed on the computers to be monitored and managed. The server 
component called the Jiffy Application Server – made up of the integrated Jiffy Server 
and Jiffy Web Console modules – has to be installed on a single computer to which the 
client stations have to have a permanent network connection throughout the duration 
of regular business operations.   
 
Note:  

• Jiffy Client will not allow customers to log in and use your computers if the Jiffy 
Application Server is not available. If the server machine becomes unavailable 
while in operation due to system or power failure, Jiffy Client will automatically 
disconnect from the server within a minute or less and protect the client station 
from unauthorised access, whether it had been in use by a customer prior to 
the failure or not. 

 
Only authorised customers and employees can gain access to your computers using 
valid customer tickets and accounts or an account with client-side administrative rights 
when Jiffy Client is running on them. 
 
Both Jiffy Server and Jiffy Client carry out billing simultaneously so that billing can be 
more reliably done. Jiffy Server updates the database every one (1) minute with the 
latest billing information, while Jiffy Client ensures that activities such as printing (if 
Print Monitoring and Billing is enabled), for instance, are duly paid for. This synergistic 
billing style ensures that in the event that either the server machine or the client 
machine goes down as a result of system or power failure, for instance, customers will 
have accurate billing information when the system is restored to normalcy. 
 
The Jiffy Client stations can be in one of the following four states at any given time: 
 

• Available – the station has connected to the Jiffy Server and customers and 
employees can log in with either a valid ticket or account and make use of it. 

 
• In Use – the station is in use by an authorised customer or employee 

 
• Locked – the station has been locked either as a result of a series of failed log 

in attempts or deliberately by an authorised employee.  
 

• Disconnected – the station is not currently connected to the Jiffy Server 
machine 

 
Using the Jiffy Web Console, you can manage your entire site (generate, activate and 
print customer tickets, manage customer accounts, configure site options, etc) and 
view all your computers to see what state they are in except when they are in the 
“Disconnected” state. This is so because your computers have to be connected to the 
Jiffy Server for them to show up on the console in the first place. Computers not 
currently connected to the Jiffy Server will naturally not show up. 
 
You will access the Jiffy Web Console by entering a URL like this: http://hostname:port 
number in a browser. Of course, you would have to enter a valid user name and 
password to be able to log in. Additionally, access to the various control and 
administrative panels are based on permissions that have been granted your user 
account or the group(s) to which you belong.  
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Figure 3-1. A screenshot of the Jiffy Web Console 
 
 
Note:  

• Only the site’s Administrator account and other members of the Administrators 
group have access to all the panels by default. Other groups and users can be 
created with one or more permissions. 
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4 Usage Scenario 

4.1 Customer Tickets 
Any authorised employee with the permission to generate customer tickets can do so 
using the Jiffy Web Console either in batches or on-demand as your customers walk in 
to your café. You would use the Ticket Assistant tool to first of all create your ticket 
categories and establish other relevant parameters used for ticket generation. 
Customers can use these tickets in multiple visits until the tickets run out of units or 
expire. 
 
When a batch of tickets is generated, twenty-eight (28) tickets are placed on an A4 
paper size page ready to be printed. Your customers cannot use tickets you generate 
unless those tickets have been activated. You may choose to generate, activate and 
print the batch in one step or generate, print and then activate later or generate and 
then print and activate later. You can generate hundreds of tickets at once depending 
on your requirements. However, it is more efficient to generate and activate tickets 
according to your current needs. It is not wise to have a large pool of activated tickets 
lying around in the database when there is no demand for them. 
 
You would resort to generating tickets on-demand if you truly want to have absolute 
control over the ticket generation and management process. On-demand ticket 
generation ensures that you generate, activate and print tickets only when your 
customers need them i.e. whenever they walk in to your café or request additional 
tickets. You would have to purchase a POS printer suitable for printing on small size 
paper to take advantage of this feature. 

 

4.2 Customer Accounts 
With Jiffy, you have the choice of creating password-protected accounts for your 
customers. Customers would log in with their account ID and password to gain access. 
You may also want to enable “Loyalty” on such accounts so that every time your 
customers credit their accounts, they receive loyalty points, which they can redeem as 
soon as they reach the required number of points or threshold that you have specified. 
Customers should change their account passwords after creation so that no one – not 
even the site’s Administrator – can tell what the passwords are: ensuring absolute 
privacy. 
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5 Setting Up Your Café 
To setup your café and get it ready for use, you would use the Jiffy Web Console to 
perform the tasks described in this chapter. This is just a guide, however. Depending 
on your needs and usage scenario, you may eventually not have to perform all of these 
tasks.  

 

5.1 Starting with the Jiffy Application Server 
The Jiffy Application Server is made up of the Jiffy Server and Web Console modules. It 
contains an embedded web server and database engine for web access and data 
storage. Thereby, providing a complete framework for managing your café both from 
within and remotely. 

 

5.1.1 Configuring the Jiffy Server 
Assuming that during the installation process of the Jiffy Application Server, you used 
the default port number for the Jiffy Server port; the Jiffy Server will be listening for 
connections from the Jiffy Client stations on port ‘5555’. However, you need to take an 
additional step to ensure that the Jiffy Client stations can connect to Jiffy Server. 
 
Activate the Jiffy Web Console in the usual manner and log in with an account that has 
administrative rights or at least the ‘Configure Jiffy Application Server options’ 
permission.  
 
 

 
 
Figure 5-1. The Jiffy Web Console log in page 
 
 
In the Web Console tree panel, click ‘Setup’ to expand the ‘Setup’ branch. Click 
‘Application Server’. In the ‘Servers’ menu, click ‘Jiffy Server’.  
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In the ‘Network Interface Options’ dialogue box, select the desired IP Address from the 
drop-down list box. This list will contain all the IP Addresses (including the loop back 
address 127.0.0.1) of the network adapter(s) currently installed on the server 
machine. If your server machine is not connected to the network, only the loop back 
address will be displayed.  
 
 
Important: If you have more than one network adapter installed on the server 
machine, make sure you specify an IP Address that is on the Local Area Network (LAN) 
interface. Do not choose the loop back address unless you are installing both the Jiffy 
Application Server and Jiffy Client on the same machine for evaluation purposes and 
your server machine is not connected to a network. 
 
Jiffy Server will bind to the selected IP Address and Port and the Jiffy Client stations 
will connect to the server machine through this network interface. 
 
When done, click the Save Changes button and then the Close button upon 
confirmation to dismiss the dialogue box. You would have to stop and restart Jiffy 
Server if it is running for the changes to take effect so that the Jiffy Client stations can 
successfully connect to the server machine. To do this, in the Web Console tree panel, 
click ‘Application Services’ to expand the ‘Application Services’ branch. Click ‘Jiffy 
Server’. In the ‘Start/Stop’ menu, click ‘Stop’. Click Okay to confirm the action and 
Okay again to dismiss the confirmation dialogue box after Jiffy Server has been 
stopped. Click ‘Start’ in the ‘Start/Stop’ menu to restart Jiffy Server. 
 
The Jiffy Client stations will now be able to connect to Jiffy Server. Go over this process 
anytime you need to bind to a different LAN IP Address. 
 

5.1.2 E-mail Server Information 
The Jiffy Application Server does not come with an e-mail server, therefore, if you 
want to take advantage of Jiffy’s ability to send reports to interested parties (customer 
account holders and report subscribers), you would have to provide information about 
another SMTP server that Jiffy can use. 
 
To provide information about an SMTP server, in the ‘Servers’ menu, click ‘E-mail 
Server’.  
 
In the ‘E-mail Server Information’ dialogue box, enter the name of the server in the 
‘Outgoing (SMTP) Server’ field. Enter the server’s port number (the default value is 25, 
change it to suit your SMTP server’s current port configuration). Enter the name of the 
mailbox that Jiffy would use to connect to the SMTP server. For privacy reasons, you 
may not use an already existing personal mailbox; instead, create one especially for 
this purpose. Specify whether the SMTP server requires authentication (most servers 
do) before a connection to the mailbox can be allowed. If your own server requires 
authentication, you must provide a valid password and confirm it. Click Save Changes 
when you are done. You can edit this information at any time. 

 

5.1.3 Setting Jiffy Web Console Options 
All café management operations are carried out with the Jiffy Web Console. To set the 
available options for Jiffy Web Console, in the ‘Servers’ menu, click ‘Web Console’.  
 
In the ‘Web Console Options’ dialogue box, enter a value for the ‘HTTP Port’ number. 
Typical values range from 0 – 65535. If you set this value to 80, you would not need 
to enter the port number along with the host name (or IP address) of the Jiffy 
Application Server machine in your web browser’s address field. Make sure that no 
other service running on the machine is currently using the port number that you 
specify.  
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A web session is created for every user who logs in to the ‘Web Console’. Jiffy relies on 
the information stored in the users’ web sessions. For instance, it uses it to determine 
what parts of the ‘Web Console’ the currently logged in user has access to. If the user 
does not use his/her web browser for the length of time specified in the ‘Users’ web 
sessions expire after’ drop-down list, the web server will expire the web session. If this 
occurs, the user will have to log in again to gain access. You may wish to change the 
length of time after which users’ web sessions will expire. To do so, select the desired 
length of time from the drop-down list. If you do not want the sessions to ever expire, 
choose ‘Never’ from the list.  
 
Click Save Changes when you are done to save the changes. 
 
Note:  

• If you changed the value of the ‘HTTP Port’, you would have to stop and restart 
the ‘Jiffy Application Server’ service or restart the machine for the changes to 
take effect. 

 
• In a business environment, you may not set the ‘Users’ web sessions expire 

after’ value to ‘Never’. A value of 30 minutes – 3 hours may be more 
appropriate. The default value is 30 minutes. 

 
 

5.1.4 Setting the Jiffy Application Server Log file Options 
The Jiffy Application Server stores its logs in a file. You can specify how large the file 
can become before it gets overwritten with new content. To do this, in the ‘Application 
Properties’ menu, click ‘Logs’. 
 
In the ‘Application Log Properties’ dialogue box, select a value for maximum file size 
(in Kilobytes) from the ‘Max log file size’ drop-down list. The default value is 32 KB. 
 
Click Close when you are done. 
 

5.1.5 Setting the Database Options 
The Jiffy Server, by default, updates the database with billing information once every 
minute. This short interval ensures that billing information is always up-to-date, 
especially in the event of power failure or any other mishap. However, this frequent 
database update means that 60 write operations (initiated by Jiffy Server during billing 
alone) are carried out by the computer’s hard drive per hour. You may also have other 
software applications installed on the server that regularly update its hard drive. The 
possibility of hard drive wear and tear may be minimised if you set the update interval 
option to a higher value than the default value of 1 minute. To do this, in the 
‘Database Properties’ menu, click ‘Database Options’. 
 
In the ‘Database Options’ dialogue box, select a value appropriate for your operational 
environment from the ‘Database update interval’ drop-down list. The default value is 1 
minute. The changes will take effect the next time Jiffy Server is started.  
 
Click Close when you are done. 
 
Note: For billing information and station uptime logs to be properly written to the 
database: 
  

• If you need to shut down the Jiffy Server machine, you must ensure that you 
shut down your Jiffy Client stations (if they are currently connected to the 
server) and then stop the Jiffy Server using the Jiffy Web Console before 
turning off the server machine. 

 
• If you need to shut down and restart the Jiffy Server machine even while your 

Jiffy Client stations are connected to the server, you should stop the Jiffy Server 
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first using the Jiffy Web Console before shutting down and restarting the server 
machine. 

 

5.1.6 Updating the Database Version 
Certain versions of the Jiffy Application Server may have additional or new features 
that require the old and existing database structure from a previous version to be 
modified in order for it to be able to support the new features. You may want to do this 
especially if you have data that you would like to retain in the old database after 
upgrading to a new version of the Jiffy Application Server. To modify the database 
from an older version, run the Database Version Update tool in the new version. To do 
this, in the ‘Database Properties’ menu, click ‘Database Version Update’. Confirm the 
action by clicking Okay in the confirmation dialogue box. The old database will be 
modified if it needs modification. 
 
Note: 

• You will get database errors if you try to use a new feature that requires a 
certain database structure that is not available. Running the Database Version 
Update tool will eliminate such errors. 

 

5.1.7 Managing the Jiffy Application Server Licence 
The Jiffy Application Server licence is based on the number of client stations or PCs 
that you wish to connect to the Jiffy Application Server. 
 
To request for a licence key for your site, register a valid licence key that you obtained 
from the vendor, or simply view your site’s licence information, in the ‘Site 
Information’ menu, click ‘Licence’. 
 
 
5.1.7.1 Requesting a licence key for your site 
In the ‘Licence Information’ dialogue box, note that some fields will be already pre-
populated with data and cannot be edited. Specify necessary additional information, 
e.g. your e-mail address and the number of client stations you wish to obtain a licence 
for. 
 
Click the ‘Request Licence Key’ button when you are done and wait for a confirmation 
that your request has been sent. Click Close to dismiss the ‘Licence Information’ 
dialogue box. 
 
Note: 

• You will receive your licence key via the e-mail address that you provided.   
 
 
5.1.7.2 Registering a licence key for your site 
Once you have obtained a valid licence key for your site, you can register it using the 
‘Licence Information’ dialogue box, note that some fields will be already pre-populated 
with data and cannot be edited. Specify the number of client stations that your licence 
covers. Set the type of licence to ‘Licensed’ and enter the licence key string in the 
‘Licence Key’ field.  
 
Click the ‘Register Licence Key’ button when you are done and wait for a confirmation. 
Click Close to dismiss the ‘Licence Information’ dialogue box. 
 
Note: 

• After you have registered your licence key, stop and restart the Jiffy Server (if it 
is running) or simply start it (if it is not running) for the new licence key 
registration to take effect. To start/stop the Jiffy Server, in the Web Console 
tree panel, click ‘Application Services’ to expand the ‘Application Services’ 
branch. Click ‘Jiffy Server’. In the ‘Start/Stop’ menu, click ‘Stop’. Click Okay to 
confirm the action and Okay again to dismiss the confirmation dialogue box 
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after Jiffy Server has been stopped. Click ‘Start’ in the ‘Start/Stop’ menu to 
restart Jiffy Server. 

 
• If you do not have a valid licence key, do not set the licence type to ‘Licensed’ 

and click ‘Register Licence Key’.  
 

 
 

5.2 Starting with Customer Tickets 

5.2.1 About Customer Tickets 
The Jiffy Application Server (version 1.8.11 and above) relies on Acrobat Reader to 
display and print the tickets that you generate. Any modern web browser (with Acrobat 
Reader installed) can display and let you print the tickets. 
 
Note:  
You must have Acrobat Reader (version 5 and above recommended) installed on the 
computer from which you intend to print your tickets. 

 

5.2.2 Using the Ticket Assistant 
 
5.2.2.1 Ticket Categories 
The Ticket Assistant is the tool you would use to create various ticket categories, 
establish other parameters necessary for ticket generation and generate, view and 
print sample tickets – in batches or on-demand.  
 
This tool is important because it makes it possible for you to do very little typing 
whenever you want to generate tickets – all you would ever need to type is the 
number of tickets that you wish to generate. 
 
To use the Ticket Assistant you would have to log in with an account that has 
administrative rights or at least the ‘Use the Ticket Assistant’ permission. In the Jiffy 
Web Console tree, click the ‘Tools’ branch to expand it. Click the ‘Tickets and Accounts’ 
sub-branch to expand it. Click the ‘Ticket Assistant’ leaf to display its menus.  
 
In the ‘Ticket Properties’ menu, click ‘Categories’ to display a list of the currently 
available ticket categories. This list would be empty if you are just setting up your café 
for the first time. Click the ‘New’ button to create a new ticket category. In the ‘Ticket 
Category’ dialogue box, enter a description for this category. Enter the desired 
monetary value in the Units text field and the amount of time in minutes the ticket is 
expected to last in the Time text field. Click Okay and wait for a confirmation. You may 
dismiss the dialogue box by clicking Close at this point or continue creating additional 
ticket categories.  
 
Note:  

• Jiffy uses the term ‘Units’ to refer to the monetary value of the customer ticket 
or customer account balance, for instance. It is expected that this value would 
be measured in the local currency and may be decimalised. Jiffy does not 
display currency signs. 

 
As stated in the ‘Ticket Category’ dialogue box tip, if you want to display multiple units 
for this category, separate each value with a comma; e.g. 60,80,100. To set the value 
‘80’ as the default, follow it with an asterisk (*), e.g. 60,80*,100. This will ensure that 
each time you wish to generate tickets, the value ’80’ would be shown as the default 
value for this ticket category. 
 
To edit any ticket category, select it and click Edit. When you finish editing the 
category click Okay in the confirmation dialogue. 
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To delete one or more ticket categories, select them and click Delete. Confirm the 
action by clicking Okay.  
 
You may click the ‘Refresh’ button in the ticket categories list to see a listing of the 
newly created ticket categories or to view changes made to the list. 
 
 
5.2.2.2 Expiration 
For customer tickets, Expiration refers to the amount of time in days a ticket is 
expected to stay valid for starting from the moment a customer first logged in with it. 
For instance, if you set the expiration for a ticket batch to 7 days, and you generated 
and activated the batch on April 3, and a customer first logged in with one of such 
tickets on April 4, his ticket will expire or no longer be valid 7 days after – April 11. He 
may use the same ticket in multiple visits subsequently after the first time, but the 
ticket will still expire on April 11 even if he still has units left on it.  
 
For customer accounts, Expiration refers to the number of days an account is expected 
to stay valid for starting from the moment the customer last logged in with it. 
For instance, if you set the expiration for a customer account to 30 days, and a 
customer logged in with that account on April 4, her account will expire or no longer be 
valid 30 days after – May 4. If she comes back to use her account before the expiration 
date of May 4, for instance April 12, the new expiration date for her account will be 
May 12. Her account will only expire if she fails to use it for the entire period of 30 
days even if she has a positive balance on her account. 
 
To modify Expiration information, you would have to log in with an account that has 
administrative rights or at least the ‘Configure Site Options’ permission. In the Jiffy 
Web Console tree, click the ‘Tools’ branch to expand it. Click the ‘Tickets and Accounts’ 
sub-branch to expand it. Click the ‘Ticket Assistant’ leaf to display its menus.  In the 
‘Ticket Properties’ menu, click Expiration to display the listing of expiration periods. 
The list would be empty if you are just setting up your site for the first time. 
 
Note:  

• You can also access Expiration information while managing Customer Accounts 
or your site, under Jiffy Site Management. 

 
Click the ‘New’ button in the expiration list window to display the ‘Expiration Period’ 
dialogue box. Enter the desired expiration period in days and check the ‘Set as default’ 
checkbox if you want this expiration period to be the default value always. Click Okay 
and wait for a confirmation. You may dismiss the dialogue box by clicking Close or you 
may continue creating additional expiration periods for your site. 
 
To edit any expiration period, select it and click Edit. When you finish editing it, click 
Okay in the confirmation dialogue box to dismiss it. 
 
To delete one or more expiration periods, select them and click Delete. Confirm the 
action by clicking Okay.  
 
You may click the ‘Refresh’ button in the expiration period list to see a listing of the 
newly created expiration periods or to view changes made to the list. 
 
5.2.2.3 Ticket/Account Usage Rules 
The default manner in which Jiffy handles ticket and account expiration may not be 
adequate for your needs. If this is the case, you may create Usage Rules that place 
additional restrictions on the way tickets and accounts are used in your café. 
 
To create, modify or delete Usage Rules, you would have to log in with an account that 
has administrative rights or at least the ‘Configure Site Options’ permission. In the Jiffy 
Web Console tree, click the ‘Tools’ branch to expand it. Click the ‘Tickets and Accounts’ 
sub-branch to expand it. Click the ‘Ticket Assistant’ leaf to display its menus.  In the 
‘Ticket Properties’ menu, click Usage Rules to display a listing of defined usage rules. 
The list would be empty if you haven’t defined any usage rules for your café. 
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Note:  
• You can also access Usage Rules while managing Customer and Employee 

Accounts, Customer Tickets or your site, under Jiffy Site Management. 
 
Click the ‘New’ button in the usage rules window to display the ‘Usage Rule’ dialogue 
box. Each item in the usage rules dialogue box is described below: 
 
Enable Rule - Determines whether the usage rule should be enabled or disabled. If it 
is enabled, the usage rule’s restrictions will be placed on any tickets or accounts that 
use it. If it is disabled, the restrictions will not be in effect for any tickets or accounts 
that use it. When creating a new usage rule, this item must be set to ‘Yes’. However, 
you may set this item to ‘No’ if you wish to disable the usage rule when you edit it. 
 
Rule Name – A unique name for the usage rule. 
 
Limit login/logout frequency to – The number of times a user is allowed to login 
and then logout per Hour/Day/Week/Month/Year. For instance, if you enter 5 and 
select Hour, a customer will only be able to login and logout 5 times in 1 hour. If he 
logs in and logs out 5 times within an hour at say, 12:15 PM, 12:25 PM, 12:30 PM, 
12:40 PM and 12:45 PM and attempts to login the sixth time at 12:50 PM or 1:15 PM, 
he will be denied access. He will only be able to gain access again anytime later than 
1:15 PM. For instance, if he attempts to login again at 1:16 PM, he will be granted 
access. However, if he decides to logout and then login again at say, 1:20 PM, he will 
be denied access again because within the last 1 hour he had logged in and logged out 
5 times. Such a customer will only be able to regain his permitted 5-time login/logout 
frequency if he waits for 1 hour or more after his last login before attempting to log 
into any of your stations. The same applies to the other options – Day, Week, Month 
and Year respectively. This usage rule item is intended to discourage customers who 
try to extend their sessions by logging in and logging out frequently, for instance, while 
downloading files or opening slow-to-load pages. 
 
Only allow usage between – The start and end times within which a customer can 
only use his or her ticket/account. For instance, if you set the times to 8:00 AM and 
12:00 PM respectively, a customer will only be able to use his ticket or account within 
this time frame. If the customer is still logged on at 12:01 PM for instance, Jiffy will log 
the customer out and display a notification for him or her. If the customer decides to 
login at any other time outside of this time frame, he or she will be denied access. If 
you do not wish to restrict the usage period to a particular time frame, set both time 
fields to 12:00 AM respectively 
 
Every – Specifies on what day of the week a customer can use his or her 
ticket/account. If you choose Day, it means the customer can access your stations with 
his or her ticket/account every day of the week. If you choose Sunday, it means that 
customer can only use his or her ticket/account on Sundays. If he or she decides to 
login on any other day of the week, he or she will be denied access. 
 
Restrict sessions to – This value specifies how long users are allowed to spend in 
minutes or hours per day, week or month. For instance, you may want to create a 
usage rule that restricts the daily or weekly sessions of your employees to one (1) 
hour per day or ten (10) hours per week.  
 
Override Ticket/Account Expiration – As stated above, Jiffy’s default expiration 
period is in days. You may want to specify a shorter length of time e.g. hours or even 
minutes. Select ‘Yes’, to override the default expiration period and ‘No’ to have Jiffy 
use the default value. If you choose ‘Yes’, Jiffy will use the value provided in Validity 
Period below instead of the one defined for the ticket or account. 
 
Validity Period – If you chose to override ticket/account expiration, you must provide 
a validity period. Enter a value and select Days, Hours or Minutes from the drop-down 
list. Jiffy will use this value instead of the one defined for the ticket/account. 
Force Ticket/Account to expire if not used within the expiration or validity 
period after activation – Again, Jiffy’s default expiration mechanism may sometimes 
not be ideal for your needs. You may want tickets/accounts to expire if they are not 
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used within a specific period after activation. To achieve this, set this item to ‘Yes’, to 
use Jiffy’s default mechanism, set it to ‘No’. 
When you are done with defining the usage rule, click Okay and wait for a 
confirmation. You may dismiss the dialogue box by clicking Close or you may continue 
defining additional usage rules for your site. 
To edit any usage rule, select it and click Edit. When you finish editing it, click Okay in 
the confirmation dialogue box to dismiss it. 
 
To delete one or more usage rules, select them and click Delete. Confirm the action by 
clicking Okay. Deleting usage rules may turn out to be a slow operation if you have lots 
of generated/activated tickets and accounts that use such rules.  Note that if you 
delete a usage rule that is use by tickets/accounts, such tickets/accounts will be set to 
use no usage rule.  
 
You may click the ‘Refresh’ button in the usage rules list to see a listing of the newly 
created usage rules or modifications made to the list. 
 
5.2.2.4 Paper Sizes 
If you choose to use the ‘Print on Demand’ ticket generation feature, then you would 
have to define paper sizes suitable for your printer of choice.  
 
To create or modify paper sizes, you would have to log in with an account that has 
administrative rights or at least the ‘Use the Ticket Assistant’ permission. In the Jiffy 
Web Console tree, click the ‘Tools’ branch to expand it. Click the ‘Tickets and Accounts’ 
sub-branch to expand it. Click the ‘Ticket Assistant’ leaf to display its menus. In the 
‘Page Setup’ menu, click ‘Paper Sizes’ to display the list of currently defined paper 
sizes. This list would be empty if you have not yet defined any paper sizes. 
 
Click the ‘New’ button in the ticket paper sizes window to show the ‘Ticket Paper Size’ 
dialogue box. Enter a description for this paper size e.g. ‘Standard’. Enter the width 
and height in centimetres (cm) and check the ‘Set as default’ checkbox if you wish for 
this paper size to be the default always. Click Okay and wait for a confirmation. Click 
Close to dismiss this dialogue box or continue to create additional paper sizes. 
 
Note:  

• The width and height you specify will depend on the paper size used by your 
printer of choice. You may have to do some experimentation to arrive at 
suitable values by generating and printing some sample tickets using the 
‘Preview Tickets’ menu of the ‘Ticket Assistant’ tool. 

 
To edit any paper size, select it and click Edit. When you finish editing it, click Okay in 
the confirmation dialogue box to dismiss it. 
 
To delete one or more paper sizes, select them and click Delete. Confirm the action by 
clicking Okay.  
 
You may click the ‘Refresh’ button in the ticket paper sizes list to see a listing of the 
newly created paper sizes or to view changes made to the list. 
 
 
5.2.2.5 Ticket Images 
You can create images, e.g. your company logo, to be displayed on your ‘Print on 
Demand’ tickets. To create or modify ticket images, you would have to log in with an 
account that has administrative rights or at least the ‘Use the Ticket Assistant’ 
permission. In the Jiffy Web Console tree, click the ‘Tools’ branch to expand it. Click 
the ‘Tickets and Accounts’ sub-branch to expand it. Click the ‘Ticket Assistant’ leaf to 
display its menus. In the ‘Ticket Images’ menu, click ‘Images’ to display the list of 
currently defined ticket images. This list would be empty if you have not yet defined 
any images. 
 
Click the ‘New’ button in the ticket images window to show the ‘Ticket Image’ dialogue 
box. Enter a description for this ticket image e.g. ‘Default Image’. Browse to the 
location of the image file on your file system and check the ‘Set as default’ checkbox if 
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you wish for this ticket image to be the default always. Click Okay and wait for a 
confirmation. Close the confirmation dialogue by clicking Okay.  
 
Note:  

• Preview one or more sample ‘Print on Demand’ tickets to ensure that the ticket 
image is suitable for your tickets using the ‘Preview Tickets’ menu of the ‘Ticket 
Assistant’ tool. 

 
To edit the properties of any ticket image, select it and click Edit. When you finish 
editing it, click Okay in the confirmation dialogue box to dismiss it. You can only 
change the description of a ticket image or its status as the default image. 
 
To delete one or more ticket images, select them and click Delete. Confirm the action 
by clicking Okay.  
You may click the ‘Refresh’ button in the ticket images list to see a listing of the newly 
created ticket images or to view changes made to the list. 
 
 
5.2.2.6 Generating Sample Tickets 
You can use the ‘Preview Tickets’ menu of the ‘Ticket Assistant’ tool to generate, view 
and even print sample tickets to see what the real tickets would look like.  
 
To be able to generate and view sample tickets, you must log in with an account that 
has administrative rights or at least at least the ‘Use the Ticket Assistant’ permission. 
In the Jiffy Web Console tree, click the ‘Tools’ branch to expand it. Click the ‘Tickets 
and Accounts’ sub-branch to expand it. Click the ‘Ticket Assistant’ leaf to display its 
menus.  
 
To generate a sample batch of tickets, in the ‘Preview Tickets’ menu, click Batch to 
display the ‘Generate Sample Batch Tickets’ dialogue box. If you have used the ‘Ticket 
Assistant’ correctly, the ‘Category’, ‘Units’, ‘Time’ and ‘Expires’ drop-down list boxes 
will be pre-populated with data.  
 
Note:  

• If any of the boxes do not contain data, you would have to use the appropriate 
menu item(s) of the ‘Ticket Assistant’ to create the missing data. 

 
Enter the number of sample tickets you want generated and click the ‘Generate’ 
button.  
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Figure 5-2. Sample Batch of Tickets 
 
To generate one or more sample ‘Print on Demand’ tickets, in the ‘Preview Tickets’ 
menu, click Print on Demand to display the ‘Generate Sample Print on Demand Tickets’ 
dialogue box. If you have used the ‘Ticket Assistant’ correctly, the ‘Category’, ‘Units’, 
‘Time’ and ‘Expires’ drop-down list boxes will be pre-populated with data.  
 
Note:  

• If any of the boxes do not contain data, you would have to use the appropriate 
menu item(s) of the ‘Ticket Assistant’ to create the missing data. 

 
• To be able print ‘Print on Demand’ tickets, you must have a suitable POS printer 

installed. 
 
Enter the number of sample tickets you want to generate and specify the output 
format – Plain Text of HTML. Click the ‘Generate’ button. To print the sample tickets, 
click the Send to Printer button.  
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Figure 5-3. Sample Print on Demand Ticket 
 
 

5.3 Starting with options for your Site 

5.3.1 About Site Management 
Jiffy offers you a plethora of options for setting up and managing your site. In order to 
use the ‘Site’ management tool, you must log in with an account that has 
administrative rights or at least the ‘Configure Site Options’ permission. 
 
To start using the ‘Site’ management tool, in the Jiffy Web Console tree, click the 
‘Setup’ branch to expand it. Click the ‘Site’ leaf to display its menus.  
 
 
5.3.1.1 Setting up a security policy for your Jiffy Client stations 
Various versions of Microsoft Windows allow you to set policy restrictions on computers 
for various reasons, e.g. security. Jiffy makes if convenient for you to set a security 
policy for your site at the operating system level.  
 
To set a security policy for your Jiffy Client stations, click Policy in the ‘Setup’ menu of 
the ‘Site’ management tool. The ‘Jiffy Client Workstation Policy’ dialogue box will be 
displayed. This dialogue box is self-describing. Select the checkboxes corresponding to 
the security policies you want to put in effect at your site. 
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When done, you can either click the ‘Save Changes’ button or the ‘Apply Changes’ 
button and wait for a confirmation. Clicking Save Changes saves the changes but the 
Jiffy Client stations will only know about the changes the next time they start up and 
connect to the Jiffy Server. Clicking Apply Changes will save the changes too but, in 
addition, these changes will be sent to the currently connected Jiffy Client stations so 
that they can take effect immediately. To remove a particular policy item from the 
selection, uncheck the corresponding checkbox. 
 
 
Note:  

• Some changes will only take effect after the stations have been restarted. 
 
 
5.3.1.2 Setting up preferences for Print Monitoring and Billing 
Jiffy provides efficient and flexible print monitoring and billing capabilities. You can 
specify how much you want to charge for print jobs sent to particular printers. You can 
also specify different charges for different print job sizes!  
 
In the Client-based scenario, print monitoring and billing is done on the Jiffy Client 
stations. The Jiffy Application Server has very little to do with this process. The only 
thing the Server needs to know about is how much you wish to charge either by 
default or according to the sizes of the print jobs sent to your printer(s). However, in 
the Server-based scenario, the Jiffy Application Server does print monitoring and 
billing. 
 
Once a customer sends a print job to one of your printers, Jiffy determines its cost 
(based on the print billing information you have provided) and checks to make sure 
that the current balance on the customer’s ticket or account can cover it. If not, the 
print job will be deleted; otherwise, it would be allowed to go to the printer and the 
customer would be charged instantly. 
 
To define your print monitoring and billing preferences, click Printing in the ‘Setup’ 
menu of the ‘Site’ management tool. The ‘Printing Information’ window containing a list 
of the currently available printers at your site will be displayed. This list will be empty if 
you have not yet included any printer(s) for print monitoring and billing. 
 
A quick and easy way to set up print monitoring and billing for any monochrome (black 
and white) and colour printers you may have in your café is to define printing charges 
for Jiffy’s built-in Default Monochrome and Default Colour printers. To do this, click the 
‘New Default…’ button. Provide the charge per page for each of the two printers in the 
‘Default Printing Setup’ dialogue box. If you only have monochrome or black and white 
printers, enter the charge for the Default Monochrome printer and leave out the charge 
for the Default Colour printer – Jiffy will set it to 0.00. Do the reverse if all your 
printers are colour printers. Click ‘Okay’ when you are done.  
 
Note that some applications may not correctly report whether the print job was 
requested in colour or monochrome, therefore, you may want to set up custom 
printers so that Jiffy can correctly determine printing charges. To add one or more 
custom printers to the list of printers to be monitored, click the ‘New Custom…’ button. 
You need to know the name of the driver of the custom printer that you wish to 
monitor.  
 
In order to determine the name of your printer’s driver, go to one of your Microsoft 
Windows stations that has the printer installed, browse to the ‘Printers’ folder in 
‘Windows Explorer’, right-click on the printer and click ‘Properties’ to display the 
printer’s properties dialogue box.  
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Figure 5-4. Microsoft Windows Printer Properties dialogue box 
 
 
Click the ‘Advanced’ tab; the name of the printer’s driver will be highlighted in the 
‘Driver’ drop-down list. 
 
In the ‘Custom Printing Setup’ dialogue box, enter the name of the printer’s driver and 
its (default) charge per page. 
 
Jiffy also allows you to specify printing charges for different print job sizes for each 
printer. A customer printing an e-mail containing a few lines of text is not the same 
thing as another customer printing a document with lots of images and heavily shaded 
tables – especially when they both use your colour printer! So, for instance, you may 
wish to charge 20 units for print jobs with a size of 0 – 100 KB, 25 units for 100 – 
200 KB, etc. You can specify charges for different print job sizes for all your printers 
including the ‘Default Monochrome’ and ‘Default Colour’ printers as well as your own 
custom printers. 
 
To specify charges for print job sizes for a particular printer, in the ‘Printing 
Information’ window, select the printer and click the ‘New Print Job Sizes…’ button. In 
the ‘Printing Job Sizes Setup’ dialogue box, to create a new print job size range, enter 
the ‘From’ and ‘To’ sizes in Kilobytes and specify the charge. If, for instance, you 
entered 0 and 100 KB in the ‘From’ and ‘To’ fields respectively and specified 20 units 
as the charge, Jiffy would charge 20 units for each page with a size of between 0 KB 
and 100 KB. You can create additional ranges starting from where you stopped in the 
previous range, e.g. 0 – 100 KB (20 units), 100 – 200 KB (25 units), 200 KB – 300 KB 
(30 units), 300 KB – 400 KB (35 units), etc. Since you cannot specify all the possible 
print job size ranges, you may define a relatively high default charge when you create 
each printer (‘Default Monochrome’, ‘Default Colour’ or your own custom printers) so 
that in the event that you have not defined a specific range, Jiffy would use the default 
charge. Again, using the print job size ranges provided above as an example, you 
could set the default charge to 40 units. If a customer sends a page with a size of 450 
KB to the printer, Jiffy would charge the customer 40 units because no range includes 
450 KB in its definition. 
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To view the defined print job sizes for a particular printer, click its name in the ‘Printing 
Information’ window. 
 
Note:  

• It is important that your printers’ drivers be properly installed on each Jiffy 
Client station in order for print monitoring and billing to work reliably. Refer to 
Installing Print Drivers for Reliable Print Monitoring and Billing in section 1.4.2.3 
of Chapter 1, for further details.  

 
• The names of these drivers have to be correctly provided when you are adding 

your own custom printers to the list of monitored printers otherwise Jiffy will 
not be able to determine the appropriate printing charges. However, Jiffy will 
not allow any print jobs to go to your printers if the charge cannot be 
determined; an error dialogue box will be displayed to inform the customer. 

 
Because Jiffy bills and charges your customers for print jobs instantly, it is equally 
important that your printers be in good working condition at all times. Your customers 
will not be happy if they get charged for faint and hard-to-read print outs, for instance. 
 
 
5.3.1.3 Configuring Jiffy Client Station Options      
Certain options can be chosen or specified for the Jiffy Client stations in your café. To 
do this, click Station Options in the ‘Station Properties’ menu of the ‘Site’ management 
tool. In the ‘Jiffy Station Options’ dialogue box, chose the desired options or enter the 
appropriate data. Click ‘Okay’ to save the changes (the changes will take effect the 
next time that the Jiffy Client stations connect to the Jiffy Server) or ‘Apply Changes’ to 
save the changes and also cause them to take effect immediately on the currently 
connected Jiffy Client stations. When you are done, click Close. 
 
 
The Jiffy Client station options are described below: 
 
Print Monitoring and Billing Type – specifies whether print monitoring (if enabled 
and depending on where your printers are on the network) should be Client-based or 
Server-based.  
 
If your printers are attached to any of your stations, including the Jiffy Server 
computer, you may choose the Client-based option. Note that you must choose this 
option if all your printers are directly connected to one or more of your stations but not 
to the server machine. It is the more flexible of the two options as it enables you to 
monitor your printers regardless of how they are connected to the network. When you 
choose this option, Print Monitoring and Billing will be carried out on the Jiffy Client 
stations. However, you will not be able to monitor and bill customers who bring their 
own laptops or PCs to your café when they print because the Jiffy Client software will 
not be running on their machines. 
 
If your printers are attached directly to the Jiffy Server machine and shared over the 
network, you may choose the Server-based option. Note that you should not choose 
this option if all your printers are not directly connected to the Jiffy Server machine. 
Although less flexible than the Client-based option, it is more secure and simpler to 
implement. With this option specified, Print Monitoring and Billing will be carried out on 
the server. No one will be able to use your printers without paying for the service while 
the Jiffy Server is running. In addition, customers who bring their own machines to 
your café will be monitored and billed accordingly. 
 
Print Monitoring and Billing Action – specifies whether or not print monitoring and 
billing will be carried out in your café and if so, how it should be done. Choose Monitor 
and Bill if you want Jiffy to monitor your printers, bill your customers for print jobs and 
log printing events in the database. If you choose this option, Jiffy will instantly 
remove the printing charge from the customer’s ticket or account balance or disallow 
and cancel the print job if the customer’s balance is not sufficient to cover the cost of 
printing. Choose Monitor if want Jiffy to only monitor your printers and log printing 
events in the database. If you choose this option, Jiffy will simply log the event and not 
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charge the customer. Customers would receive a notification informing them of how 
much they should subsequently pay for their print job(s). To turn Print Monitoring and 
Billing off or disable it, chose ‘No’. This option is set to ‘No’ by default. 
 
Allow Jiffy Client to be stopped via the Station Management Console – specifies 
whether or not users who log into Jiffy Client stations as Station Manager can stop Jiffy 
using the Station Management Console. When you have finished setting up your café, 
setting this option to ‘No’ is advised, as users will not be able to arbitrarily stop Jiffy on 
your stations without reason. This option is set to ‘Yes’ by default.  
 
Auto-log in for Station Manager when the Jiffy Server is unavailable – specifies 
whether or not a user can log in to the Jiffy Client stations as Station Manager without 
having to provide a user name and password after the Jiffy Server has gone down e.g. 
as result of network or power failure, in order to stop Jiffy or shutdown the stations. In 
a business environment, you should choose ‘No’ for this option. This option is set to 
‘No’ by default. 
 
Number of unsuccessful user log in attempts before station is locked – a 
customer or user may try to use a non-existent customer ticket, customer account or 
administrative account either maliciously or otherwise. 
 
This number specifies the number of times a customer or user is allowed to 
consecutively attempt to log in to a Jiffy Client station without success before the 
station becomes locked. Upon being locked, only the site’s ‘Administrator’ or a user 
with the ‘Station Management’ permission can unlock the station using the Jiffy Web 
Console. Setting the number to 0 or leaving the field blank will cause Jiffy not to lock 
the station regardless of the number of failed login attempts. Doing this is not ideal in 
a business environment. A value of 3 – 5 is recommended. The default value for this 
option is 3. 
 
Close all applications immediately when users log off or their sessions expire 
– specifies whether or not applications opened by the customer or user would be 
closed upon the user logging off either wilfully or forcefully (upon the expiration of 
his/her session or network failure). This option is set to ‘No’ by default. 
 
How long to wait before closing all applications after users log off or their 
sessions expire – specifies how long, in minutes, Jiffy should wait before attempting 
to close all the applications opened by the customer or user upon the user logging off 
either wilfully or forcefully (upon the expiration of his/her session or network failure). 
Setting the number to 0 or leaving the field blank will cause Jiffy not to attempt to 
close the applications. This field is left blank by default. 
 
Enable addition of tickets – specifies whether or not customers can merge tickets 
(add tickets to their current tickets) on the Jiffy Client stations. It is recommended that 
you set this option to ‘Yes’ in a business environment. This option is set to ‘Yes’ by 
default. 
 
Maximum number of web browser windows allowed for each user – specifies 
the number of web browser windows a user is allowed to open at the same time. Once 
a user opens more browser windows than specified, Jiffy will close the additional 
windows ensuring that the number of windows left does not exceed the specified 
number. Setting the number to 0 or leaving the field blank will cause Jiffy not to 
monitor the number of open web browser windows. This field is left blank by default. 
 
Warning: 

• This feature may have undesirable effects, for instance, if a user starts out with 
one (1) browser window and then opens additional windows by following links 
from the first window, the windows will share a single process identification 
number. Therefore, if any of the windows is closed because the maximum 
allowable number has been exceeded, the first window (and all the other 
windows) will be closed! The user will end up with no window at all! In addition, 
this feature will not be effective if you have installed a web browser that has 
tabbed-browsing like Mozilla Firefox. A user may simply do all his browsing in 
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one window and open as many sites as he desires, thereby, by-passing this 
restriction. 

 
 
5.3.1.4 Defining Billing Rates For Your Site 
The term ‘Rates’ refers to the amount of units you would charge your customers for 
using your PCs per minute. Jiffy uses ‘Rates’ for charging your customers who opt to 
maintain customer accounts with your café. You would also need to create special 
‘Rates’ that you wish to charge for specific stations or at different times of the day or 
night during your business hours.  
 
For instance, if you wish to charge your customers 100 units for 1 hour (60 minutes), 
then you would create the rate: 100/60 = 1.67 (units/min). Jiffy allows you to create 
as many rates as you would ever need. 
 
To create a new rate or view existing rates, click Rates in the ‘Site Properties’ menu of 
the ‘Site’ management tool. The ‘Rates’ window containing a list of the currently 
available rates will be displayed. This list will be empty if you haven’t yet defined any 
rates.  
 
Click the ‘New’ button to add a new rate to the list. In the ‘Rate’ dialogue box, enter 
the value of the new rate.  
 
To specify whether it should be the default rate in dialogue boxes where rates appear, 
check the ‘Set as default’ check box. You may create additional rates. Click Close when 
you are done. 
 
To edit any rate, select it and click Edit. When you finish editing the rate click Okay in 
the ‘Rate’ dialogue box. 
 
To delete one or more rates, select them and click Delete. Confirm the action by 
clicking Okay.  
 
You may click the ‘Refresh’ button in the rates list to see a listing of the newly created 
rates or to view changes made to the list.  
 
 
5.3.1.5 Defining Special Station Rates 
Jiffy allows you to charge special rates for specific stations or PCs in your café. When a 
customer logs in to a Jiffy Client station with a ticket or account, Jiffy first checks to 
see if you have set any special rate for that station. If you have, Jiffy will disregard the 
rate that applies to the ticket or customer account and use the special rate you have 
set for the station to bill the customer instead.  
 
To create a new station rate or view existing station rates, click Station Rates in the 
‘Station Properties’ menu of the ‘Site’ management tool. The ‘Station Rates’ window 
containing a list of the currently available station rates will be displayed. This list will 
be empty if you have not yet defined any station rates.  
 
Click the ‘New’ button to add a new station rate to list. In the ‘Station Rate’ dialogue 
box, enter the computer name of the station in the ‘Station’ field and select the rate to 
apply to the station from the ‘Rate’ drop-down list. This list will be empty if you have 
not yet created any rates for your site (see section 5.3.1.4 above for details).  
 
You may create additional station rates for other stations. Click Close when you are 
done. 
 
To edit any station rate, select it and click Edit. When you finish editing the rate click 
Okay in the ‘Station Rate’ dialogue box. 
 
To delete one or more station rates, select them and click Delete. Confirm the action 
by clicking Okay.  
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You may click the ‘Refresh’ button in the station rates list to see a listing of the newly 
created rates or to view changes made to the list.  
 
 
Note:  

• ‘Station Rates’ override all the other billing rate options. 
 
• ‘Station Rates’ will not take effect in your site unless you enable it in ‘Rate 

Options’ (see section 5.3.1.10 below for details). 
 
 
5.3.1.6 Defining Special Day/Night-Time Rates 
In addition to letting you define special station rates, Jiffy also lets you specify special 
‘Day/Night-Time Rates’ that you can charge your customers at specific times of the day 
or night during your business hours. For instance, you may wish to have Happy Hour, 
Peak-Time and Off Peak-Time rates. When a customer logs in to a Jiffy Client station 
with a ticket or account, Jiffy first checks to see if you have set any special rate for 
that station. If you have not, Jiffy will then check to see if you have defined any yearly, 
monthly or weekly rates that are applicable in that order. If no applicable rate is found, 
Jiffy will finally check to see if you have defined any day/night-time rate for that time 
of day or night. If you have, Jiffy will disregard the rate that applies to the ticket or 
customer account and use the day/night-time rate you have set to bill the customer 
instead.  
 
To create a new day/night-time rate or view existing day/night-time rates, click 
‘Day/Night-Time Rates’ in the ‘Site Properties’ menu of the ‘Site’ management tool. 
The ‘Day/Night-Time Rates’ window containing a list of the currently available 
day/night-time rates will be displayed. This list will be empty if you have not yet 
defined any day/night-time rates.  
 
Click the ‘New’ button to add a new day/night-time rate to the list. In the ‘Day/Night-
Time Rate’ dialogue box, select the start and end times from the ‘Start’ and ‘End’ drop-
down lists respectively and select the rate to apply to the period from the ‘Rate’ drop-
down list. This list will be empty if you have not yet created any rates for your site (see 
section 5.3.1.4 above for details).  
 
You may create additional day/night-time rates for your site. Click Close when you are 
done. 
 
Note: 

•  ‘Station Rates’, ‘Yearly Rates’, ‘Monthly Rates’ and ‘Weekly Rates’ override 
‘Day/Night-Time Rates’. 

 
• ‘Day/Night-Time Rates’ will not take effect in your site unless you enable it in 

‘Rate Options’ (see section 5.3.1.10 below for details). 
 
 
5.3.1.7 Defining Special Weekly Rates 
Jiffy also lets you specify special ‘Weekly Rates’ that you can charge your customers on 
specific days of the week. For instance, you may wish to charge differently on Fridays, 
Sundays or any other day of the week. When a customer logs in to a Jiffy Client station 
with a ticket or account, Jiffy first checks to see if you have set any special rate for 
that station. If you have not, Jiffy will then check to see if you have defined any yearly 
or monthly rates that are applicable in that order. If no applicable rate is found, Jiffy 
will then check to see if you have defined any weekly rate for that particular day of the 
week. If you have, Jiffy will disregard the rate that applies to the ticket or customer 
account and use the weekly rate you have set to bill the customer instead.  
 
To create a new weekly rate or view existing weekly rates, click ‘Weekly Rates’ in the 
‘Site Properties’ menu of the ‘Site’ management tool. The ‘Weekly Rates’ window 
containing a list of the currently available weekly rates will be displayed. This list will 
be empty if you have not yet defined any weekly rates.  
 



Jiffy® Internet Café Manager Manual  Revision 1.8.20070718 

© 2007 Creektown Software Limited. All rights reserved. 

36 

36 

Click the ‘New’ button to add a new weekly rate to the list. In the ‘Weekly Rate’ 
dialogue box, select the day of the week from the ‘Day of the week’ drop-down list and 
select the rate to apply to that day from the ‘Rate’ drop-down list. This list will be 
empty if you have not yet created any rates for your site (see section 5.3.1.4 above for 
details).  
 
You may create additional weekly rates for your site. Click Close when you are done. 
 
Note: 

• ‘Station Rates’, ‘Yearly Rates’ and ‘Monthly Rates’ override ‘Weekly Rates’. 
However, ‘Weekly Rates’ override ‘Day/Night-Time Rates’. 

 
• ‘Weekly Rates’ will not take effect in your site unless you enable it in ‘Rate 

Options’ (see section 5.3.1.10 below for details). 
 
 
5.3.1.8 Defining Special Monthly Rates 
Jiffy also lets you specify special ‘Monthly Rates’ that you can charge your customers 
on specific days of the month. For instance, you may wish to charge differently on the 
1st or 30th day of every month. When a customer logs in to a Jiffy Client station with a 
ticket or account, Jiffy first checks to see if you have set any special rate for that 
station. If you have not, Jiffy will then check to see if you have defined any yearly rate 
that is applicable. If no applicable rate is found, Jiffy will then check to see if you have 
defined any monthly rate for that particular day of the month. If you have, Jiffy will 
disregard the rate that applies to the ticket or customer account and use the monthly 
rate you have set to bill the customer instead.  
 
To create a new monthly rate or view existing monthly rates, click ‘Monthly Rates’ in 
the ‘Site Properties’ menu of the ‘Site’ management tool. The ‘Monthly Rates’ window 
containing a list of the currently available monthly rates will be displayed. This list will 
be empty if you have not yet defined any monthly rates.  
 
Click the ‘New’ button to add a new monthly rate to the list. In the ‘Monthly Rate’ 
dialogue box, select the day of the month from the ‘Day of month’ drop-down list and 
select the rate to apply to that day from the ‘Rate’ drop-down list. This list will be 
empty if you have not yet created any rates for your site (see section 5.3.1.4 above for 
details).  
 
You may create additional monthly rates for your site. Click Close when you are done. 
 
Note:  

• ‘Station Rates’, ‘Yearly Rates’ override ‘Monthly Rates’. However, ‘Monthly 
Rates’ override ‘Weekly Rates’ and ‘Day/Night-Time Rates’. 

 
• ‘Monthly Rates’ will not take effect in your site unless you enable it in ‘Rate 

Options’ (see section 5.3.1.10 below for details). 
 
 
5.3.1.9 Defining Special Yearly Rates 
Finally, Jiffy also lets you specify special ‘Yearly Rates’ that you can charge your 
customers at specific times of the year. For instance, you may wish to charge 
differently on special days like holidays e.g. December 25th or 1st of January every 
year. When a customer logs in to a Jiffy Client station with a ticket or account, Jiffy 
first checks to see if you have set any special rate for that station. If you have not, 
Jiffy will then check to see if you have defined any yearly rate that is applicable. If you 
have, Jiffy will disregard the rate that applies to the ticket or customer account and 
use the yearly rate you have set to bill the customer instead.  
 
To create a new yearly rate or view existing yearly rates, click ‘Yearly Rates’ in the 
‘Site Properties’ menu of the ‘Site’ management tool. The ‘Yearly Rates’ window 
containing a list of the currently available yearly rates will be displayed. This list will be 
empty if you have not yet defined any yearly rates.  
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Click the ‘New’ button to add a new yearly rate to the list. In the ‘Yearly Rate’ dialogue 
box, select the month and the day of the month from the ‘Month’ and ‘Day of month’ 
drop-down lists respectively and then select the rate to apply to that day from the 
‘Rate’ drop-down list. This list will be empty if you have not yet created any rates for 
your site (see section 5.3.1.4 above for details).  
 
You may create additional yearly rates for your site. Click Close when you are done. 
 
Note:  

• ‘Station Rates’ override ‘Yearly Rates’. However, ‘Yearly Rates’ override 
‘Monthly Rates’, ‘Weekly Rates’ and ‘Day/Night-Time Rates’. 

 
• ‘Yearly Rates’ will not take effect in your site unless you enable it in ‘Rate 

Options’ (see section 5.3.1.10 below for details). 
 
 
5.3.1.10 Setting Billing Rate Options For Your Site 
You can choose to either enable or disable one or more of the available billing rate 
options. To do this, click Rate Options in the ‘Setup’ menu of the ‘Site’ management 
tool. In the ‘Rate Options’ dialogue box, chose the desired options. Click ‘Okay’ to save 
the changes. When you are done, click Close. 
 
Note: 

• Do not enable any of the rate options if you have not defined any applicable 
rates for such options. This will help Jiffy avoid the penalty of having to check 
the database for any applicable rates each time customers log in to your Jiffy 
Client stations.  

 
 
 
The rate options are described below: 
 
Enable Station rates for Jiffy Client stations – specifies whether or not station 
rates will be in effect in your café. To turn it on at anytime, chose ‘Yes’; to turn it off or 
disable it, chose ‘No’. This option is set to ‘No’ by default. 
 
Enable Day/Night-Time rates – specifies whether or not day/night-time rates will be 
in effect in your café. To turn it on at anytime, chose ‘Yes’; to turn it off or disable it, 
chose ‘No’. This option is set to ‘No’ by default. 
 
Enable Weekly rates – specifies whether or not weekly rates will be in effect in your 
café. To turn it on at anytime, chose ‘Yes’; to turn it off or disable it, chose ‘No’. This 
option is set to ‘No’ by default. 
 
Enable Monthly rates – specifies whether or not monthly rates will be in effect in 
your café. To turn it on at anytime, chose ‘Yes’; to turn it off or disable it, chose ‘No’. 
This option is set to ‘No’ by default. 
 
Enable Yearly rates – specifies whether or not yearly rates will be in effect in your 
café. To turn it on at anytime, chose ‘Yes’; to turn it off or disable it, chose ‘No’. This 
option is set to ‘No’ by default. 
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6 User and Group Management 

6.1 About Users and Groups 
You can easily manage ‘Users’ and ‘Groups’ using the Jiffy Web Console. The term 
‘Users’ refers to employees e.g. attendants, site administrators or other personnel (not 
customers) who are responsible for running and managing your café. 
 
Each user you create will have a set of permissions that determines what operations 
he/she is allowed to carry out as part of his/her job definition or responsibilities. 
Although, you can grant/revoke permissions to users individually, it is far easier to 
manager them in ‘Groups’. For instance, if you had more than one attendant, you 
could create a group called ‘ATTENDANTS’, define permissions for this group and then 
make each one of them a member of the group. They will each inherit the permissions 
defined for the group ‘ATTENDANTS’. You may also grant additional permissions to 
users individually. 
 
To be able to manage users and groups, you must log in with an account that has both 
the ‘Create, delete and edit Users and Groups’ and ‘View Users and Groups’ 
permissions. 
 
To manage users and groups, in the Web Console tree panel, click the ‘Tools’ branch to 
expand it. Click the ‘Groups and Users’ leaf to expose the ‘User and Group’ 
management tool.  

 

6.1.1 Groups 
 
6.1.1.1 Creating Groups 
To create a new group, click ‘Create Group’ in the ‘Groups’ menu of the ‘User and 
Group’ management tool. 
 
In the ‘Create Group’ dialogue box, enter a name for the new group. Make sure there 
are no commas in the provided name. Click Save to create the group. You may create 
additional groups. Click Close when you are done. 
 
The group(s) you just created would not, as yet, have a set of permissions. To assign 
permissions to the newly created group(s), click ‘Groups’ in the ‘View’ menu of the 
‘User and Group’ management tool. This displays a list of the currently available 
groups in the ‘Group Summary’ window. 
 
In the ‘Group Summary’ list, click the name of the group whose permissions you want 
to set or modify. This brings up the ‘Group Properties’ window showing the properties 
of the group including its permissions. 
 
In the permissions list, select the appropriate permissions you would like to assign to 
this group (see section 6.2 below to learn more about permissions). To save the 
changes, click ‘Save Changes’ when you are done. Click Close to dismiss the ‘Group 
Properties’ window. 
 
To edit the name of any group, select it in the ‘Group Summary’ list and click Edit. 
When you finish editing the group, click Save in the ‘Edit Group’ dialogue box. Click 
Close to dismiss the dialogue box. 
 
To delete one or more groups, select them and click Delete. Confirm the action by 
clicking Okay.  
 
You may click the ‘Refresh’ button in the group summary list to see a listing of the 
newly created groups or to view changes made to the list.  
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To view the members of any group, select the group in the ‘Group Summary’ list and 
click the ‘Members…’ button. This brings up the ‘Group Members’ window containing a 
list of the members of the group. 
 
To add one more members to this group, click the ‘Add…’ button. In the ‘Add Group 
Members’ dialogue box, enter the user names of the users you would like add to this 
group, separating them with a comma. You can only add existing users to a group 
using this method (see section 6.1.2.1 below for details on how to create users).  
 
When you are done providing the user names, click the ‘Add Users’ button to add the 
users to the selected group. Click Close to dismiss the ‘Add Group Members’ dialogue 
box. 
 
To remove one or more members from a group, select the members(s) in the ‘Group 
Members’ list and click the ‘Remove’ button. Confirm the action by clicking Okay. 
 
Note: 

• A user must belong to at least one group for the user to be able to exercise any 
set of individual permissions that he/she may have. If you remove a user from 
all his/her groups, the user will still be able to log in to the Web Console but will 
not be able to do anything, even if the user has individual permissions. 

 
• If you delete a group, all the users who belonged to the group will still exist and 

be able to log in to the Web Console. However, the same conditions described 
above will still apply to them. 

 
• You cannot delete the built-in ‘ADMINISTRATORS’ group or edit its properties.  

 
 

6.1.2 Users 
 
6.1.2.1 Creating Users 
To create a new user, click ‘Create User’ in the ‘Users’ menu of the ‘User and Group’ 
management tool. 
 
In the ‘Create User’ dialogue box, enter a unique user name for the new user. Provide 
the user’s full name. Enter a password and confirm it (users can change their 
passwords if they have the ‘Change own password’ permission). Select a group to add 
the user to from the ‘Select Group(s)’ list. You can add the user to more than one 
group, if you wish. Click Save to create the user. You may create additional users. Click 
Close when you are done. 
 
The user(s) you just created will inherit the permissions of all the groups they belong 
to. To assign additional permissions for the newly created user(s), click ‘Users’ in the 
‘View’ menu of the ‘User and Group’ management tool. This displays a list of the 
currently available users in the ‘Users’ window. 
 
In the ‘Users’ list, click the name of the user whose permissions you want to set or 
modify. This brings up the ‘User Properties’ window showing the properties of the user 
including his/her permissions. 
 
In the permissions list, select the additional permissions you would like to assign to 
this user (see section 6.2 below to learn more about permissions). Notice that the 
permissions inherited from the group(s) to which the user belongs are greyed-out and 
cannot be changed or revoked for this user (except at the group level). The user’s 
individual permissions (if any) are not, allowing you to revoke them. To save the 
changes, click ‘Save Changes’ when you are done. Click Close to dismiss the ‘User 
Properties’ window. 
 
To edit the properties (user name, full name, password and group(s)) of any user, 
select the name of the user in the ‘Users’ list and click Edit. When you finish editing the 
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user’s properties, click Save in the ‘Edit User’ dialogue box. Click Close to dismiss the 
dialogue box. 
 
To delete one or more users, select them and click Delete. Confirm the action by 
clicking Okay.  
 
You may click the ‘Refresh’ button in the user list to see a listing of the newly created 
users or to view changes made to the list.  
 
Note: 

• If you delete a user, the user will be removed from all the groups that he/she 
belongs to and will no longer be able to log in to the Web Console. 

 
 
6.1.2.2 Changing User Passwords 
A user may, from time to time, want a password change either for security reasons or 
as result of forgetting his/her password. 
 
In the event that a user forgets his/her password or simply wants a new password but 
does not have the ‘Change own password’ permission, the user would have to depend 
on the site’s Administrator or another user who has both the ‘Create, delete and edit 
Users and Groups’ and ‘View Users and Groups’ permissions to edit the user’s 
properties.  See section 6.1.2.1 for details on how to do this. 
  
If you are a user who has the ‘Change own password’ permission you can, however, 
change your own password while you are logged in to the Web Console. To do this, 
click ‘Change Password’ in the ‘Users’ menu of the ‘User and Group’ management tool. 
 
In the ‘Change Password’ dialogue box, provide your current password (the change will 
not be allowed if you do not provide the correct password). Enter a new password and 
confirm it. Click Save Changes to save the changes. Click Close to dismiss the dialogue 
box. Use the new password the next time you wish to log in to the Web Console. 
 
 

6.2 Understanding Permissions 
Jiffy’s flexible permissions framework allows you to easily grant and revoke 
permissions to and from your employees and other personnel.  
 
The table below describes the available permissions in detail.  
 
 
Permission Details 
 
User and Groups 
 

 

1. Create, delete and edit Users and 
Groups 

Permits the user to create, edit and delete 
users and groups. A user with this 
permission also needs the ‘View Users and 
Groups’ permission to fully carry out user 
and group management. 
 

2. View Users and Groups Permits the user to view users and 
groups. A user with this permission does 
not necessarily need to have the ‘Create, 
delete and edit Users and Groups’ 
permission – unless it is required. 
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3. Change own password Permits the user currently logged in to the 
Web Console to change his/her password. 
This permission may be granted to all 
users except where it is necessary that 
password changes be known or authorised 
by someone else e.g. the business owner 
or site Administrator.  
 

 
Setup 
 

 

4. Configure Jiffy Application Server 
options 

 

Permits the user to configure options for 
the Jiffy Application Server. This 
permission should be restricted to 
business owners or top-level site 
administrators. 
  

5. Configure Site Options 
 

Permits the user to configure options 
(expiration, customer loyalty, printing, 
etc) for the entire site. This permission 
should be restricted to business owners or 
top-level site administrators. 
 

6. Download and Apply Jiffy Updates Permits the user to apply downloaded 
software updates of Jiffy Client on 
currently connected stations. 
This permission may be granted to system 
administrators, site administrators, etc. 
 

 
Tickets 
 

 

7. Use the Ticket Assistant Permits the user to use the Ticket 
Assistant to create ticket categories, 
define paper sizes (for Print on Demand 
tickets), upload ticket images and preview 
sample tickets. 
This permission should be restricted to 
business owners or top-level site 
administrators. 
 

8. Print Batch Permits the user to generate/activate (and 
print instantly) tickets in batches. 
This permission may be granted to any 
user who is responsible for generating 
tickets. 
 

9. Print on Demand Permits the user to generate/activate (and 
print instantly) Print on Demand tickets. 
This permission may be granted to any 
user who is responsible for generating 
tickets. 
 

10. Activate Tickets Permits the user to activate tickets 
previously generated either by the same 
user or another user. 
This permission may be granted to any 
user who is responsible for generating 
tickets. 
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11. Deactivate Tickets Permits the user to deactivate tickets 
previously generated either by the same 
user or another user. 
This permission may be granted to any 
user who is responsible for generating 
tickets. 
 

12. View Activated Tickets Permits the user to view activated tickets 
previously activated either by the same 
user or another user. 
This permission may be granted to any 
user who is responsible for 
generating/activating tickets. 
 

13. View Ticket Files Permits the user to view tickets files 
previously generated and saved (on the 
server) either by the same user or 
another user. 
This permission may be granted to any 
user who is responsible for 
generating/activating tickets. 
 

14. Delete Ticket Files Permits the user to delete tickets files 
previously generated and saved (on the 
server) either by the same user or 
another user. 
This permission may be granted to any 
user who is responsible for 
generating/activating tickets. 
 

 
Accounts 
 

 

15. Create and edit Customer Accounts 
 

Permits the user to create and edit 
customer accounts. A user with this 
permission also needs the ‘View activated 
Accounts’ permission to fully carry out 
customer account management. 
 

16. View activated Accounts 
 

Permits the user to view activated 
customer accounts. A user with this 
permission does not necessarily need to 
have the ‘Create and edit Accounts’ 
permission – unless it is required. 
 

17. Credit Accounts, View Payments 
 

Permits the user to credit customer 
accounts. A user with this permission may 
also need the ‘View activated Accounts’ 
permission but it is not necessary. 
 

18. Create and edit Employee Accounts Permits the user to create and edit 
employee accounts. A user with this 
permission also needs the ‘View activated 
Accounts’ permission to fully carry out 
employee account management. This 
permission should be restricted to 
business owners. 
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Services 
 

 

19. Manage the Jiffy Server (Start/Stop, 
View Status) 

 

Permits the user to start, stop and view 
the status of the Jiffy Server.  
This permission should be restricted to 
business owners and top-level site 
administrators. 
 
 

20. Manage the Jiffy Proxy (Stop/Start, 
View Status) 

Permits the user to start, stop and view 
the status of the Jiffy Proxy Server.  
This permission should be restricted to 
business owners and top-level site 
administrators. 
 
 

 
Jiffy Client Stations 
 

 

21. Station Management 
 

Permits the user to shut down, restart and 
lock/unlock currently connected Jiffy 
Client stations, view/end open 
applications running on the stations and 
send a message to the stations using the 
Web Console. 
It also allows the user to log in locally to 
the Jiffy Client stations as ‘Station 
Manager’ to configure Jiffy or 
shutdown/restart the station. 
This permission may be granted to 
attendants, system administrators, etc. 
 

 
Reports 
 

 

22. Create and Save Reports 
 

Permits the user to create and save 
reports. 
This permission should be restricted to 
business owners and top-level site 
administrators or anyone who is charged 
with reporting. 
 

23. Use the Report Assistant, View and 
Manage Report Subscribers 

 

Permits the user to use the ‘Report 
Assistant’ to manage report subscribers 
(e-mail addresses to which reports are 
periodically sent) and to define a schedule 
for sending the reports.  
This permission should be restricted to 
business owners and top-level site 
administrators or anyone who is charged 
with reporting. 
 

24. View Saved Reports 
 

Permits the user to view saved reports. 
This permission should be restricted to 
business owners and top-level site 
administrators or anyone who is charged 
with reporting. 
 

25. Delete Saved Reports 
 

Permits the user to delete saved reports. 
This permission should be restricted to 
business owners. 
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Logs 
 

 

26. View Jiffy Application Server Logs 
 

Permits the user to view and delete log 
data in the Jiffy Application Server log file. 
This permission may be restricted to 
business owners, top-level site 
administrators and system administrators. 
 

 
Data Manager 
 

 

27. Use the Database Assistant, 
Backup/Restore data 

 

Permits the user to use the ‘Database 
Assistant’ to backup and restore data and 
to define a schedule for automatic data 
backups.  
This permission should be restricted to 
business owners and top-level site 
administrators. 
 

28. View Generated Tickets 
 

Permits the user to view tickets generated 
either by the same user or another user. 
This permission may or may not be 
granted to users who are responsible for 
generating tickets. 
 

29. View Generated Accounts 
 

Permits the user to view customer 
accounts generated either by the same 
user or another user. 
This permission may be granted to any 
user who is responsible for generating 
accounts. 
 

30. View Activity Logs 
 

Permits the user to view logs of printing 
activity, customer account payments, 
customer ticket/account usage, station 
uptimes and account loyalty realisation or 
redemption. 
This permission may be granted to any 
customer-facing user. 
 

31. Delete Data using the Data Manager 
 

Permits the user to delete generated 
tickets, customer accounts and all activity 
logs. 
This is by far the most important 
permission and should be restricted to 
business owners. 
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7 Customer Tickets 

7.1 Understanding Customer Tickets 
A Customer Ticket is a paper-based token that grants a visitor to your café access to 
any PC on which an installation of Jiffy Client is active. To gain access, the visitor must 
provide the ticket’s Ticket ID and matching password, which Jiffy authenticates to 
make sure that the ticket is valid and has not expired.  
 

7.1.1 Customer Ticket Management 
 
7.1.1.1 Understanding Customer Ticket Generation and Activation 
When Jiffy generates customer tickets, they are placed in the database but are not 
made available for use by your customers until they have been activated. Depending 
on your needs, you may choose to generate and activate the tickets in one step or 
generate them for later activation. This may be necessary especially if different people 
are respectively charged with generating tickets and activating them for better 
accountability. 
 
 
7.1.1.2 Generating Ticket Batches 
Jiffy allows you to generate tickets in batches (28 tickets are placed on one A4 sheet of 
paper). This is an efficient and economical way of printing tickets as you can print as 
many tickets as you need (up to 5000) in one step and put them all in one batch. In a 
business environment, you should however, not generate and activate more tickets 
than you really need at any given time. 
 
To generate tickets in batches, you should be logged in with an account that has the 
‘Print Batch’ permission. 
 
To generate a batch of tickets, in the Jiffy Web Console tree, click the ‘Tools’ branch to 
expand it. Click the ‘Tickets and Accounts’ sub-branch to expand it. Click the ‘Tickets’ 
leaf to display its menus and then click Batch in the ‘Generate/Print’ menu. 
 
In the ‘Generate Batch Tickets’ dialogue box, select the ticket category from the 
‘Category’ drop-down list. Select the appropriate values from the ‘Units’, ‘Time’ and 
‘Expires’ drop-down lists. If you have created any usage rules and you want the tickets 
to use one of them, select it from the ‘Usage Rule’ drop-down list. Choose ‘None’ if you 
do not want the tickets to use any usage rule. Finally, enter the number of tickets you 
would like to generate in the ‘Number’ field. 
 
At this point, you have two options to choose from regarding how you want to perform 
the ticket generation process.  
 
You can decide whether to generate and activate the tickets in one step or to generate 
the tickets first and then activate them later. Depending on your needs, click either the 
‘Generate and activate now’ or ‘Generate and activate later’ button.  When the tickets 
are displayed, click the Send to Printer button to print the tickets. 
 
Note: 
Before sending the tickets to the printer, make sure you remove any footers and 
headers that may appear on the printed tickets. To do so, open your web browser’s 
Page Setup utility and ensure the header and footer fields are both empty. Also ensure 
that the margins (left, right, top and bottom) are all set to zero (0). Your browser may 
reset these values but they should not be greater than 2 millimetres otherwise the 
tickets will not be fully displayed when printed. 
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Figure 7-1. Generated Ticket Batch 
 
 
7.1.1.3 Generating Print on Demand Tickets 
Print on Demand tickets are generated whenever customers need or demand tickets 
e.g. as they walk into your café or when their current ticket runs out of units. This 
ensures that you only generate what you require and will never have unused tickets 
lying around in the database. Since these tickets are printed on demand, they are 
generated and activated in one step. 
 
To generate tickets on demand, you should be logged in with an account that has the 
‘Print on Demand’ permission. 
 
To generate one or more Print on Demand tickets, in the Jiffy Web Console tree, click 
the ‘Tools’ branch to expand it. Click the ‘Tickets and Accounts’ sub-branch to expand 
it. Click the ‘Tickets’ leaf to display its menus and then click Print on Demand in the 
‘Generate/Print’ menu. 
In the ‘Generate Print on Demand Tickets’ dialogue box, select the ticket category from 
the ‘Category’ drop-down list. Enter the number of tickets you would like to generate in 
the ‘Number’ field. Select the appropriate values from the ‘Units’, ‘Time’ and ‘Expires’ 
drop-down lists. If you have created any usage rules and you want the ticket to use 
one of them, select it from the ‘Usage Rule’ drop-down list. Choose ‘None’ if you do not 
want the ticket to use any usage rule. Select a paper size from the ‘Paper Size’ drop-
down list and specify the output format.  
 
If you choose Plain Text as the output format, specifying an image is not supported. If 
you choose HTML as the output format and if a ticket image is available and is 
required, select it from the ‘Image on Ticket’ drop-down list. Finally click the ‘Generate’ 
button. 
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Figure 7-2. Generated Print on Demand Ticket 
 
 
To print the generated ticket(s), click the Send to Printer button. 
 
Note: 

• In order to get satisfactory printouts from your POS, you may have to adjust 
the left and right margins using your browsers Page Setup utility. Also, ensure 
that you remove any footers and headers that your browser may automatically 
add to printed documents. 

 
 
 
7.1.1.4 Viewing Activated Customer Tickets 
Activated customer tickets are tickets that are available for use by your customers. 
Once a ticket is exhausted (when the units on it run out), expires or is deactivated, it 
is removed from the set of activated tickets and hence becomes unavailable. You can 
view the currently activated tickets in your café at any time. To do so, you must log in 
with an account that has the ‘View Activated Tickets’ permissions. 
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To view activated tickets, in the Jiffy Web Console tree, click the ‘Tools’ branch to 
expand it. Click the ‘Tickets and Accounts’ sub-branch to expand it. Click the ‘Tickets’ 
leaf to display its menus and then click Activated Tickets in the ‘View’ menu. 
 
In the ‘View Activated Tickets’ dialogue box, a number of options are available to you 
to help you refine your search so you can quickly find what you are looking for. 
 
From the ‘Display tickets activated’ options specify the appropriate timeframe. To 
restrict the search to the current day, for instance, choose the ‘between and’ option 
and specify the day’s date in both date fields. You may further refine your search by 
specifying the type of results you would like to see in the ‘Type’ drop-down list. To 
search for all the tickets in a particular batch of tickets, provide its Batch ID either 
partially or in full and set the type to ‘Batch with ID’. To search for a particular ticket, 
you must provide its Ticket ID in full and set the type to ‘Ticket with ID’. To see all the 
ticket batches that were activated within a particular timeframe, set the type to ‘All’.  
Click Okay when you are done. 
 
If you opted to view one or more ticket batches by setting the type to either ‘All’ or 
‘Batch with ID’, you can click Batch ID in the results pane to see the tickets contained 
in each batch. 
 
 
7.1.1.5 Activating Customer Tickets 
Activating previously generated customer tickets makes them available for use by your 
customers. You can activate tickets individually or in batches.  
 
To activate tickets, you should be logged in with an account that has the ‘Activate 
Tickets’ permission. 
 
To activate a ticket or a batch of tickets, in the Jiffy Web Console tree, click the ‘Tools’ 
branch to expand it. Click the ‘Tickets and Accounts’ sub-branch to expand it. Click the 
‘Tickets’ leaf to display its menus and then click Activate in the ‘Activate/Deactivate’ 
menu. 
In the ‘Activate Tickets’ dialogue box, specify whether you want to activate an 
individual ticket or a batch of tickets. To activate an individual ticket, enter its Ticket 
ID and make sure Ticket ID is selected. To activate a ticket batch, enter its Batch ID 
and make sure Batch ID is selected. Click Okay and wait for a confirmation. Click Close 
to dismiss the dialogue box when you are done. 
 
Note: 

• You can only activate tickets that exist or have previously been generated. 
 

• You cannot activate (reactivate) tickets that have been deactivated or already 
activated. 

 
7.1.1.6 Deactivating Customer Tickets 
Deactivating previously generated and activated customer tickets makes them 
unavailable for use by your customers. You may want to deactivate tickets for various 
reasons – for instance, because of an error during the ticket generation and activation 
process or outright theft. You can deactivate tickets individually or in batches.  
 
To deactivate tickets, you should be logged in with an account that has the ‘Deactivate 
Tickets’ permission. 
 
To deactivate a ticket or a batch of tickets, in the Jiffy Web Console tree, click the 
‘Tools’ branch to expand it. Click the ‘Tickets and Accounts’ sub-branch to expand it. 
Click the ‘Tickets’ leaf to display its menus and then click Deactivate in the 
‘Activate/Deactivate’ menu. 
 
In the ‘Deactivate Tickets’ dialogue box, specify whether you want to deactivate an 
individual ticket or a batch of tickets. To deactivate an individual ticket, enter its Ticket 
ID and make sure Ticket ID is selected. To deactivate a ticket batch, enter its Batch ID 
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and make sure Batch ID is selected. Click Okay and confirm the action. Click Close to 
dismiss the dialogue box when you are done. 
 
Note: 

• You can only deactivate tickets that exist or have previously been generated 
and activated. 

 
• You cannot deactivate tickets that are currently in use by customers. 
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8 Customer and Employee Accounts 

8.1 Understanding Customer Accounts 
Instead of using tickets, some of your customers may opt to operate password-
protected accounts such that whenever they visit, they provide their Account ID, which 
Jiffy authenticates to make sure that the account is valid and has not expired. 
Customers are expected to have enough units in their accounts to be able to pay for 
your services. They can, however, top up their accounts if they have no units left.  
Only authorised employees can credit customers’ accounts. 
 
Customer accounts give you the ability to reward your customers for their loyalty. See 
section 8.1.1.2 for more on customer loyalty. 

 

8.1.1 Customer Account Management 
 
8.1.1.1 Understanding Customer Account Generation and Activation 
When Jiffy generates a customer account, it is immediately activated. However, it will 
have a balance of 0.00 units and the account holder will not be able to use your 
services until the account has been credited with units. 
 
 
8.1.1.2 Understanding Customer Account Loyalty 
Jiffy gives you the ability to reward your loyal customers for their patronage. Once you 
enable ‘Loyalty’ in your café, you can specify the customers to whom your reward 
would be extended by enabling ‘Loyalty’ for such customers in their account profiles. 
 
For such customers, each time they credit their accounts, a certain number of loyalty 
points is saved for them based on the discount you have specified. When the number 
of points reaches the threshold that you have set for your café, the points are realised 
or redeemed, converted to useable units and added to their current account balance.  
 
For instance, if you specified a discount of 5% and set your threshold to 1000 points, 
for every 100 units that a customer credits to his account, he receives 5 units or 50 
points (1 unit = 10 points). If the customer keeps visiting your café and continues to 
top up his account, his loyalty points will eventually reach the 1000 point-threshold, 
upon which he will automatically have 100 units added to his account balance. The 
value of his loyalty points will be reset to 0 and he will be taken through the cycle 
again. 
 
Your customers will always be eligible for loyalty point rewards as long as they 
regularly visit your café and keep topping up their accounts. You can turn off ‘Loyalty’ 
in your café generally or for particular customers whenever it is necessary to do. 
 
  
8.1.1.3 Setting up Customer Account Loyalty 
To enable/disable or set up customer account loyalty parameters for your café, you 
should be logged in with an account that has the ‘Configure site options’ permission. 
 
To set up customer account loyalty, in the Jiffy Web Console tree, click the ‘Tools’ 
branch to expand it. Click the ‘Tickets and Accounts’ sub-branch to expand it. Click the 
‘Accounts’ leaf to display its menus and then click Loyalty in the ‘Account Properties’ 
menu. 
 
In the ‘Account Loyalty’ dialogue box, specify whether or not ‘Loyalty’ should be 
enabled in your café. To enable it, set Enable loyalty to Yes. Otherwise, to disable it, 
set Enable loyalty to No. Provide the value of the discount you wish to give your loyal 
customers each time they credit their accounts in the ‘Discount’ field. This value should 
be between 0 and 100. Your customers do not get this discount immediately but it is 
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saved for them as points until it reaches a certain amount. Specify this amount (in 
points) in the ‘Required points for loyalty realisation’ field. 
 
Note: 

• If you choose to disable ‘Loyalty’ none of your customers will be eligible for 
point rewards even if they have ‘Loyalty’ enabled in their account profiles. 

 
 
8.1.1.4 Generating Customer Accounts 
To generate or create customer accounts, you should be logged in with an account that 
has the ‘Create and edit Customer Accounts’ permission. 
 
To generate a new customer account, in the Jiffy Web Console tree, click the ‘Tools’ 
branch to expand it. Click the ‘Tickets and Accounts’ sub-branch to expand it. Click the 
‘Accounts’ leaf to display its menus and then click Create Customer Account in the 
‘Accounts’ menu. 
 
In the ‘Customer Account’ dialogue box, provide the account holder’s full name and 
enter a unique Account ID for the account. Provide a password and confirm it. From 
the ‘Rate’ drop-down list, select a billing rate that will apply to the account. Jiffy allows 
you to specify how long an account will stay valid for, after the customer’s last visit to 
your café. If the account holder does not visit your café within this length of time, 
his/her account will be considered to have expired. Set this value in the ‘Expires’ drop-
down list. If you have created any usage rules and you want the account to use one of 
them, select it from the ‘Usage Rule’ drop-down list. Choose ‘None’ if you do not want 
the account to use any usage rule. To enable ‘Loyalty’ for the customer account, check 
the ‘Enable loyalty’ checkbox. To send an account status report to the account holder 
by e-mail, check the ‘Send report by e-mail’ checkbox and provide the account holder’s 
e-mail address. Click Okay and wait for a confirmation. Click Close to dismiss the 
dialogue box. 
 
Note: 

• For Jiffy to be able to send reports by e-mail to account holders, you must have 
provided information about your e-mail server in Setup. 

 
 
8.1.1.5 Crediting Customer Accounts 
To credit customer accounts, you should be logged in with an account that has the 
‘Credit Accounts, View Payments’ permission. 
 
To credit an account, in the Jiffy Web Console tree, click the ‘Tools’ branch to expand 
it. Click the ‘Tickets and Accounts’ sub-branch to expand it. Click the ‘Accounts’ leaf to 
display its menus and then click Credit Customer Account in the ‘Payments’ menu. 
 
In the ‘Credit Account’ dialogue box, enter the amount of units you wish to pay into the 
account and select the account’s Account ID from the ‘Account ID’ drop-down list. Click 
Okay and wait for a confirmation. Click Close to dismiss the dialogue box. 
 
Note: 

• Only valid accounts can have units credited to them at anytime. Expired 
accounts cannot receive payments. 

 
 
8.1.1.6 Viewing Activated Customer Accounts 
To view activated customer accounts, you should be logged in with an account that has 
the ‘View Activated Accounts’ permission. 
 
To view activated accounts, in the Jiffy Web Console tree, click the ‘Tools’ branch to 
expand it. Click the ‘Tickets and Accounts’ sub-branch to expand it. Click the ‘Accounts’ 
leaf to display its menus and then click Activated Customer Accounts in the ‘View’ 
menu. 
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In the ‘View Activated Accounts’ dialogue box, select the ‘Account ID’ of the account 
whose details you wish to view. To view all accounts, select ‘ALL ACCOUNTS’. Click 
Okay. 
 
You may want to edit the properties (e.g. its password, loyalty status, etc) of an 
account. To do so, select the account and click the ‘Edit’ button in the results pane. 
You may also deactivate one or more accounts by selecting them and clicking the 
‘Deactivate’ button.  
 
 
8.1.1.7 Viewing Account Payments 
You can view all payments made into accounts by authorised employees and personnel 
in your café.  
 
To view account payments, you should be logged in with an account that has the 
‘Credit Accounts, View Payments’ permission. 
 
To view account payments, in the Jiffy Web Console tree, click the ‘Tools’ branch to 
expand it. Click the ‘Tickets and Accounts’ sub-branch to expand it. Click the ‘Accounts’ 
leaf to display its menus and then click Payments in the ‘View’ menu. 
 
In the ‘View Account Payments’ dialogue box, a number of options are available to you 
to help you refine your search so you can quickly find what you are looking for. 
 
From the ‘Display payments made’ options specify the appropriate timeframe. To 
restrict the search to the current day, for instance, choose the ‘between and’ option 
and specify the day’s date in both date fields. You may further refine your search by 
specifying the Account ID of the specific account whose payment details you are 
interested in seeing in the ‘Account ID’ drop-down list. To see payments for all the 
accounts within a particular timeframe, set the ‘Account ID’ to ‘ALL ACCOUNTS’.  
Click Okay.  
 
In the results pane, to view the details for each account, click its Account ID. 
 
 
8.1.1.8 Activating Customer Accounts 
As stated above, once a new customer account is generated, it is activated. Therefore, 
you would have no need to activate it. However, you may need to activate an account 
again for instance, if Jiffy had deactivated it upon expiration. Jiffy deactivates accounts 
that have expired when their holders attempt to log in to Jiffy Client stations with 
them. You may need to activate such accounts again if their account holders still desire 
to use them 
 
To activate an account, you should be logged in with an account that has the ‘Create 
and Edit Customer Accounts’ permission. 
 
To activate an account, in the Jiffy Web Console tree, click the ‘Tools’ branch to expand 
it. Click the ‘Tickets and Accounts’ sub-branch to expand it. Click the ‘Accounts’ leaf to 
display its menus and then click Activate in the ‘Accounts’ menu. 
 
In the ‘Activate Account’ dialogue box, enter the Account ID of the account that you 
want to activate. Click Okay and wait for a confirmation. Click Close to dismiss the 
dialogue box when you are done. 
 
Note: 

• You can only activate accounts that exist or have previously been generated 
and deactivated. 

 
• You cannot activate accounts that have been already activated. 
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8.1.1.9 Deactivating Customer Accounts 
Deactivating previously generated and activated customer accounts makes them 
unavailable for use by their holders. You may want to deactivate an account for various 
reasons – for instance, because the holder wants to temporarily suspend its usage.  
 
To deactivate an account, you should be logged in with an account that has the ‘Create 
and Edit Accounts’ permission. 
 
To deactivate an account, in the Jiffy Web Console tree, click the ‘Tools’ branch to 
expand it. Click the ‘Tickets and Accounts’ sub-branch to expand it. Click the ‘Accounts’ 
leaf to display its menus and then click Deactivate in the ‘Accounts’ menu. 
 
In the ‘Deactivate Account’ dialogue box, select the Account ID of the account that you 
wish to deactivate from the ‘Account ID’ drop-down list. Click Okay and confirm the 
action. Click Close to dismiss the dialogue box when you are done. 
 
Note: 

• You can only deactivate accounts that exist or have previously been generated 
and activated. 

 
• You cannot deactivate accounts that are currently in use by customers. 

 
 
 

8.2 Understanding Employee Accounts 
You may create password-protected accounts for your employees if you want them to 
gain access to your Jiffy Client stations while at work. To log in, an employee will 
provide his or her Account ID and Jiffy will authenticate it to make sure that the 
account is valid and has not expired. Employees are not required to have units in their 
accounts for successful log on (Jiffy does not provide a way for Employee Accounts to 
receive credit). As a result, Employee Accounts will not be able to print while they are 
logged on if you have enabled Print Monitoring and Billing with the Monitor and Bill 
option selected. 
 

8.2.1 Employee Account Management 
 
8.2.1.1 Understanding Employee Account Generation and Activation 
When Jiffy generates an employee account, it is immediately activated. The account 
holder will be able to have unlimited access to your services without having to pay for 
them. To provide any restrictions, you may create one or more usage rules that you 
can use to define when and how these employee accounts may be used in your café.   
 
 
8.2.1.2 Generating Employee Accounts 
To generate or create employee accounts, you should be logged in with an account 
that has the ‘Create and edit Employee Accounts’ permission. 
 
To generate a new employee account, in the Jiffy Web Console tree, click the ‘Tools’ 
branch to expand it. Click the ‘Tickets and Accounts’ sub-branch to expand it. Click the 
‘Accounts’ leaf to display its menus and then click Create Employee Account in the 
‘Accounts’ menu. 
 
In the ‘Employee Account’ dialogue box, provide the account holder’s full name and 
enter a unique Account ID for the account. Provide a password and confirm it. Jiffy 
allows you to specify how long an employee account will stay valid for, after the last 
time it was used. If the account holder does not use the account within this length of 
time, the account will be considered to have expired. Set this value in the ‘Expires’ 
drop-down list. If you have created any usage rules and you want the employee 
account to use one of them, select it from the ‘Usage Rule’ drop-down list. Choose 
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‘None’ if you do not want the account to use any usage rule. Click Okay and wait for a 
confirmation. Click Close to dismiss the dialogue box. 
 
Note: 

• To learn how to view and manage Employee Accounts, please refer to Customer 
Account Management in section 8.1.1 above. 
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9 The Jiffy Server and Jiffy Client 

9.1 How the Jiffy Server works 
The Jiffy Server is the component within the Jiffy Application Server that communicates 
with and controls the Jiffy Client stations and offers such services as customer 
ticket/account authentication and authorisation, billing, etc. 
 
The Jiffy Application Server that is installed as a service on your operating system 
automatically starts up the Jiffy Server each time your server machine boots up. 
Therefore, you do not need to log in to the server machine locally to start and control 
the Jiffy Server process. The Jiffy Client stations will be able to connect to the Jiffy 
Server once it has successfully opened a network interface connection for 
communicating with the stations. 
 
Jiffy does not provide a separate program or GUI for interacting with the Jiffy Server. 
You will use the Jiffy Web Console for carrying out all the required tasks. This means 
that you can effectively control your café from any of your PCs or from anywhere in the 
world using a web browser. 

 

9.1.1 Managing the Jiffy Server 
 
9.1.1.1 Starting the Jiffy Server 
As noted before, the Jiffy Server does not require you to manually start it because it is 
started automatically each time the server machine boots up. However, there are 
times when you may need to start it yourself. For instance, if it failed to open the 
configured network interface port (because another process is using it), you will need 
to start it after you have corrected the problem. 
 
To start the Jiffy Server, you should be logged in with an account that has the ‘Manage 
the Jiffy Server (Start/Stop, View Status)’ permission. 
 
To start the Jiffy Server, in the Jiffy Web Console tree, click the ‘Application Services’ 
branch to expand it. Click the ‘Jiffy Server’ leaf to display its menus and then click 
Start in the ‘Start/Stop’ menu. 
 
Note: 

• You can only start the Jiffy Server if it is not already running. 
 
 
9.1.1.2 Stopping the Jiffy Server 
You can stop the Jiffy Server anytime it is necessary to do so. If there are Jiffy Client 
stations currently connected to the server, they will be forced to disconnect and billing 
will stop. The Jiffy Client stations, on their own, will also log off the active users and 
will not be available for use until the Jiffy Server is restarted. 
 
To stop the Jiffy Server, you should be logged in with an account that has the ‘Manage 
the Jiffy Server (Start/Stop, View Status)’ permission. 
 
To stop the Jiffy Server, in the Jiffy Web Console tree, click the ‘Application Services’ 
branch to expand it. Click the ‘Jiffy Server’ leaf to display its menus and then click Stop 
in the ‘Start/Stop’ menu. Confirm the action by clicking Okay. 
 
Note: 

• You can only stop the Jiffy Server if it is already running. 
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9.1.1.3 Viewing the Jiffy Server status 
You can see a brief summary of the state the Jiffy Server is in currently by viewing its 
status. You will see when it started, how many Jiffy Client stations are connected and 
the total number of active customer tickets/accounts. 
 
To view the Jiffy Server status, you should be logged in with an account that has the 
‘Manage the Jiffy Server (Start/Stop, View Status)’ permission. 
 
To view the status of the Jiffy Server, in the Jiffy Web Console tree, click the 
‘Application Services’ branch to expand it. Click the ‘Jiffy Server’ leaf to display its 
menus and then click Status in the ‘View’ menu. 
 
Note: 

• You can only view the status of the Jiffy Server if it is running. 
 
 
9.1.1.4 Viewing Jiffy Application Server logs 
The Jiffy Application Server keeps a log of its activities in a log file. You can view this 
log file to see, for instance, if the Jiffy Server started successfully or not and if tasks 
like database backups were carried out as scheduled. 
 
To view the Jiffy Application Server logs, you should be logged in with an account that 
has the ‘View Jiffy Application Server Logs’ permission. 
 
To view the logs of the Jiffy Application Server, in the Jiffy Web Console tree, click the 
‘Application Services’ branch to expand it. Click the ‘Jiffy Server’ leaf to display its 
menus and then click Application Logs in the ‘View’ menu. 
 
Each bit of information in the log is classified according to its type – Information, Error 
and Warning. The contents of the log file are cleared automatically if its size equals the 
size you specified in Setup. However, you can clear them anytime by clicking the ‘Clear 
Logs’ button in the ‘Jiffy Application Server Logs’ window. 
 
 

9.2 How Jiffy Client works 
Jiffy Client is the software component that is installed on the PCs that you want to 
protect from unauthorised access. Only customers whose tickets/accounts are valid 
and have a positive balance can gain access. Employees or other personnel, who have 
the ‘Station Management’ permission can also log in to the stations as ‘Station 
Manager’ to shutdown, reboot or manage the stations.  
 
Jiffy Client can be configured to lock the station when users wrongly provide their ID 
and/or password successively a certain number of times while attempting to log in. You 
specify this number in Setup. No one will be able to log in to the station until it has 
been unlocked. A user with the ‘Station Management’ permission can unlock one or 
more locked stations using the Web Console. 
 
Jiffy also protects your stations by ensuring that two or more users cannot use the 
same ticket or account on two or more different stations at the same time. Even a user 
who has the ‘Station Management’ permission cannot be logged in to more than one 
station at the same time. He must first log off from one station before he can gain 
access to another. 
 
Jiffy Client requires the Jiffy Server to be up and running before users can gain access 
to your PCs. If the Jiffy Client cannot contact the server upon starting up, no one can 
log in to the station, as Jiffy does not provide a user account with which you can log in 
locally to by-pass the Jiffy Server. 
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9.2.1 Starting Jiffy Client on your stations 
 
9.2.1.1 Starting Jiffy Client 
To start Jiffy Client, either for the first time after installing it on your PC or after 
stopping it, click the Jiffy icon on your desktop or browse to the directory or folder 
where you installed Jiffy Client on your local hard disk drive and double-click the 
‘jiffy.exe’ program file. You can only start Jiffy this way if you are logged in to Microsoft 
Windows with a user account that has Administrative rights. 
 
Every time Jiffy Client starts up, it needs to know the preferred Microsoft Windows user 
account with which to enforce policy and security settings. Therefore, when you start 
Jiffy Client, you are prompted with the ‘Start Jiffy’ dialogue box, offering you two 
options of starting Jiffy to choose from. The default option is to start Jiffy Client with 
the currently logged in user account. You may use this option to quickly start Jiffy 
Client to make sure that it can connect to the Jiffy Server with the current 
configuration on a particular station. Starting Jiffy Client this way in a business 
environment is not recommended for two reasons: 
 

• The ‘Start Jiffy’ dialogue box will be displayed every time Jiffy Client starts after 
the PC finishes loading Microsoft Windows. You would have to click Okay in the 
dialogue box for Jiffy Client to completely load. This mode of starting Jiffy is 
referred to as Manual mode because it needs your intervention.  

 
• Anyone can stop Jiffy from running by clicking the ‘Cancel’ button in the ‘Start 

Jiffy’ dialogue box.  
 
The other option is to specify or create a Microsoft Windows account for Jiffy to use. If 
the user account does not exist, Jiffy will create it and give it ‘User’ privileges. You 
could also specify an already existing user account. This user account may have 
Administrative rights, but this is not recommended as your computer will be exposed 
to threats from viruses, worms, spy ware and recalcitrant users who often need 
Administrative rights in order to be able to effect changes to the computer system. 
Using a ‘User’ account greatly minimises this threat. 
 
With this option, every time the PC starts, the system will use the provided account to 
automatically log in to Microsoft Windows and Jiffy Client will start up as soon as 
Microsoft Windows finishes loading without presenting the ‘Start Jiffy’ dialogue box. 
This mode of starting Jiffy is referred to as Auto mode because a user account is used 
to automatically log in to Microsoft Windows and Jiffy Client is started without your 
intervention. In a business environment, this is the recommended way to start Jiffy 
Client. 
 
If Jiffy Client successfully connects to the Jiffy Server, your customers and other users 
will be able to log in to the stations and begin to use your services. 
 
Note: 

• It is recommended that you always start Jiffy Client in Auto mode and that you 
always use the same preferred Microsoft Windows user account each time. Any 
security and policy changes made to the account will be undone whenever you 
stop Jiffy Client. 

 
 

9.2.2 Using the Station Management Console to manage 
stations. 
 
9.2.2.1 Stopping Jiffy Client 
You may want to stop Jiffy Client either to uninstall it from your PC or to stop it from 
running the next time the PC starts, for instance. 
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To be able to stop Jiffy Client on any station, select the ‘Station Manager’ option in the 
Jiffy Client log in panel and enter the ID and password of a user account that has the 
‘Station Management’ permission. Click the ‘Log In’ button to log in. 
To stop Jiffy Client, click the ‘Stop Jiffy’ button in the Station Management Console. 
 
Note: 

• You may not stop Jiffy Client unless it is absolutely necessary to do so. When 
you stop Jiffy Client, it will undo all the policy and security settings it had put in 
effect for the preferred user account with which you used to start it. It will also 
not run the next time the PC starts up. This ensures that you end up with a 
clean system, which is especially good if your intention is to completely uninstall 
Jiffy Client from your computer. However, if you need to have Jiffy Client start 
up the next time your PC starts, you would have to start it manually and go 
over the process described in section 9.2.1.1. 

 
 
9.2.2.2 Shutting down and Rebooting Jiffy Client stations 
You can either shutdown or reboot the Jiffy Client stations remotely using the Web 
Console or locally using the Station Management Console. 
  
To be able to shutdown or reboot a Jiffy Client station locally, select the ‘Station 
Manager’ option in the Jiffy Client log in panel and enter the ID and password of a user 
account that has the ‘Station Management’ permission. Click the ‘Log In’ button to log 
in. 
 
To shutdown the Jiffy Client station, click the ‘Shutdown Station’ button in the Station 
Management Console. 
 
To reboot the Jiffy Client station, click the ‘Reboot Station’ button in the Station 
Management Console. 
 
Note: 

• Shutting down and rebooting your stations, either remotely with the Web 
Console or locally with the Station Management Console, do not affect the 
current start-up mode of Jiffy Client. The next time your PCs start, Jiffy Client 
will start up as currently configured (either in Manual or Auto mode). 

 
 
9.2.2.3 Logging off the currently logged-in Windows User 
You can log off the currently logged-in Windows user without having to stop Jiffy Client 
or reboot the machine by using the Station Management Console. For instance, you 
may want to do this because the currently logged-in user may not have the 
Administrative rights required to enable you install software or carry out system 
maintenance and therefore, you may need to log in to Windows as a different user. 
  
To be able to log off the currently logged-in Windows user, select the ‘Station Manager’ 
option in the Jiffy Client log in panel and enter the ID and password of a user account 
that has the ‘Station Management’ permission. Click the ‘Log In’ button to log in. 
 
To log off, click the ‘Log off from Windows’ button in the Station Management Console. 
 
Note: 

• Logging off the currently logged-in Windows user in this manner does not affect 
the current start-up mode of Jiffy Client. If a different user logs in or the next 
time the station starts, Jiffy Client will start up as currently configured (either in 
Manual or Auto mode). 

 
 
9.2.2.4 Specifying Programs that are allowed to run on Jiffy Client stations. 
Jiffy Client makes it possible to specify which installed software programs are allowed 
to run on each station. This offers a number of advantages, one of which is system 
security.  
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Since only certain known programs are allowed to run, all others that are unknown, 
including worms and spy ware are automatically denied the right to execute on the 
target system. 
 
To be able to specify what programs can run on a Jiffy Client station, you must be 
logged in to Microsoft Windows with a user account that has Administrative rights. 
Start Jiffy Client if is not already running. Select the ‘Station Manager’ option in the 
Jiffy Client log in panel and enter the ID and password of a user account that has the 
‘Station Management’ permission. Click the ‘Log In’ button to log in. 
 
On the left-hand side of the Station Management Console, click ‘Specify what programs 
are allowed to run on this station’. This will display a list of programs currently allowed 
to run on the station. This list will be empty if no such programs have been defined – 
every program currently installed on the station will be able to run as a result.  
 
To add one or more programs to the list of allowed programs, in the ‘Run Programs’ 
dialogue box, click the ‘Add…’ button. In the ‘Add to list’ dialogue box, enter the 
program file name of the program that you want to allow to run, e.g. for Internet 
Explorer, enter iexplore.exe, for Windows Explorer, enter explorer.exe, for Notepad, 
enter notepad.exe, etc. and click Okay. To add another program to the list, click the 
‘Add…’ button again. Repeat this procedure for each program you want to allow to run. 
When you are done, click Okay in the ‘Add to list’ dialogue box to dismiss it. 
 
The changes will be applied the next time Jiffy Client starts up. To apply them 
immediately, stop and restart Jiffy Client as usual, making sure to specify the preferred 
Microsoft Windows user account for Jiffy to use. 
 
To remove any program from the list off allowed programs at any time, open the list of 
allowed programs as described above. Select the program(s) in the ‘Run Programs’ 
dialogue box and click the ‘Remove’ button.  
 
After starting (or stopping) Jiffy Client, for the applied changes to take effect, reboot 
the station. 
 
Note: 

• Be careful how you use this feature. Always make sure that you start Jiffy Client 
with the preferred Microsoft Windows user account, so that any system changes 
will be made to only this account. The changes made to this user account will 
be undone whenever you stop Jiffy Client. 

 
 
9.2.2.5 Specifying The Welcome Image on Jiffy Client stations. 
The Welcome Image is the image that is displayed on available or idle Jiffy Client 
stations. You can change this image (using the same image or different images) on 
each station to suit your needs. You may want to replace the default image with one 
that advertises your café as well as other services you render. 
 
The image should have the following dimensions: 500 pixels (width) x 400 pixels 
(height) and may be a bitmap, jpeg or gif file. Animated gif images may be used to 
enhance the delivery of your messages. The latest version of Jiffy Client contains an 
animated version of Jiffy's default welcome image. The image file (‘jiffy_anim_img.gif’) 
is located in the 'images' folder under the directory in which you installed Jiffy Client. 
You could set it as the welcome image to get an idea of what you could achieve with 
your own images. 
 
To be able specify the welcome image to display on a Jiffy Client station; you must be 
logged in to Microsoft Windows with a user account that has Administrative rights. 
Start Jiffy Client if is not already running. Select the ‘Station Manager’ option in the 
Jiffy Client log in panel and enter the ID and password of a user account that has the 
‘Station Management’ permission. Click the ‘Log In’ button to log in. 
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On the left-hand side of the Station Management Console, click ‘Specify the image to 
be displayed on the Jiffy welcome screen’. This will open the file dialogue box. Browse 
to the location of the file of the image you want to use as your welcome image. This 
file should exist on the hard disk drive of the target station so that Jiffy Client can 
quickly locate and load it upon starting up. If it is located on an external drive or 
somewhere on your network, copy it to a location on the hard disk drive of the target 
system.  
Click Open in the file dialogue box after you have selected the desired file. Finally, 
uncheck the ‘Use default welcome image’ checkbox to specify that you wish to use 
your own custom image.  
 
Note: 

• Check the ‘Use default welcome image’ checkbox anytime you wish to use the 
default image.  

 

 
9.2.2.6 Specifying the Jiffy Server Network Interface options. 
As stated before, upon starting up, Jiffy Client will not allow anyone to log in to the 
stations if the stations fail to connect to the server, perhaps as a result of a bad 
network connection or network configuration problems. Therefore, you must ensure 
that the two network interface properties – the host name of the Jiffy Server machine 
and the network port it is listening on – have been correctly set up on each station. 
 
However, it may become necessary to change the values of these properties after you 
have initially set up the Jiffy Client stations. To be able to make these changes on any 
station, you must be logged in to Microsoft Windows with a user account that has 
Administrative rights. Start Jiffy Client if it is not already running so that the station 
can connect to the server in the usual manner. Select the ‘Station Manager’ option in 
the Jiffy Client log in panel and enter the ID and password of a user account that has 
the ‘Station Management’ permission. Click the ‘Log In’ button to log in. 
 
On the lower part of the left-hand side of the Station Management Console, click 
Server Options. In the ‘Server Options’ panel, click the ‘Edit’ button to switch to edit 
mode. Make the desired changes and click the ‘Apply’ button when you are done. Jiffy 
Client will use the new network interface properties the next time it starts up or 
attempts to connect to the Jiffy Server. You have to carry out this procedure on all 
your PCs. 
 
Note: 

• When you are done with the Jiffy Client stations, effect the same changes to the 
configuration of the Jiffy Server in Setup using the Jiffy Web Console.  

 
• If you need to make any changes to the network interface properties of your 

Jiffy installation, always begin with the stations. If you start with the Jiffy 
Server, you may not be able to log in to the stations to make the required 
changes unless you have enabled ‘Auto-log in for Station Manager when the 
Jiffy Server is unavailable’ (the stations have to have made an initial connection 
to the server for this feature to be of any use). 

 

9.2.3 Using the Web Console to manage stations 
The Jiffy Web Console offers you the ability to control your entire café either locally 
from within or remotely via the Internet. One of the tasks that you can effectively 
perform is managing your Jiffy Client stations in real-time.  
 
You can, for instance, see the currently active customers and users on each station, 
the balance on their tickets/accounts, how much time they have left and the programs 
or applications they have opened on their respective stations. You can even shut these 
programs down! You can also shutdown, reboot, lock or unlock the stations and send 
messages to the users on all the connected stations. 
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To be able to manage the Jiffy Client stations, you should be logged in with an account 
that has the ‘Station Management’ permission. 
 
To manage the stations in your café, in the Jiffy Web Console tree, click the ‘Tools’ 
branch to expand it. Click the ‘Jiffy Clients’ leaf to display its menus and then click 
Active Stations in the ‘View’ menu. 
 
In the ‘Jiffy Stations’ window, a list of all the stations currently connected to the server 
will be displayed. The status of each station will be highlighted in different colours to 
signify its current state. The colour Green signifies that the station is currently 
available or idle; Yellow signifies that it is in use either by a customer with an account 
or ticket or by one of your authorised users who has logged in to the station as ‘Station 
Manager’. While Red signifies that it has been locked either deliberately by authorised 
personnel or as a result of a customer or a user reaching the number of consecutive 
failed login attempts that you set in Station Options in Setup.   
 
 
9.2.3.1 Sending messages to active Jiffy Client stations. 
To send a message to any of the stations, select them from the list of active stations in 
the ‘Jiffy Stations’ window and click the ‘Send A Message…’ button. In the ‘Send A 
Message’ dialogue box, enter the body of the message you want to send in the 
‘Message’ text area. When you are done, click Send. Click Close to dismiss the dialogue 
box. 
 
Note: 

• If you do not specify the stations that you want to send your message to by 
selecting them from ‘Jiffy Stations’ list, your message will be sent to all the 
currently active stations. This is a valuable short cut, so you do not have to 
perform the station selection process when the intention is to broadcast the 
message to everyone.  

 
 
9.2.3.2 Shutting down active Jiffy Client stations. 
To shutdown any of the stations, you must select them from the list of active stations 
in the ‘Jiffy Stations’ window and click the ‘Shutdown’ button. Confirm the action by 
clicking Okay. The selected stations will be shutdown as requested. 
 
 
9.2.3.3 Rebooting active Jiffy Client stations. 
To reboot any of the stations, you must select them from the list of active stations in 
the ‘Jiffy Stations’ window and click the ‘Reboot’ button. Confirm the action by clicking 
Okay. The selected stations will be rebooted as requested. 
 
 
9.2.3.4 Locking/Unlocking active Jiffy Client stations. 
You may want to lock (and later unlock) a Jiffy Client station to, for instance, forcefully 
log off a customer or to make it temporarily unavailable for use by anyone. 
 
To lock or unlock any of the stations, you must select them from the list of active 
stations in the ‘Jiffy Stations’ window and click the ‘Lock/Unlock’ button. Confirm the 
action by clicking Okay. Each of the selected stations will be locked or unlocked as 
requested depending on its previous status. If a station was locked before you clicked 
Lock/Unlock, it will be unlocked. If it was unlocked (not locked), it will be locked. 
 
Note: 

• Locking and unlocking a station is useful whenever the Jiffy Client log in panel 
becomes disabled and the mouse cursor enters the wait state. No one will be 
able to log in to a station if its log in panel is in such a state. This may happen 
when a customer or user tries to log in and the Jiffy Server does not send an 
appropriate response to the station. Locking and unlocking the station when this 
happens, will enable the log in panel once again, making it possible for 
customers and other users to log in. 
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9.2.3.5 Viewing application programs running on active Jiffy Client stations. 
You can view all the applications that a customer or user has opened on each station.  
 
To see the programs running on any station, click the name of the station in the 
‘Station’ column of the ‘Jiffy Stations’ listing of the active stations. A list of programs 
currently running on the station will be displayed in the ‘User Applications’ window. To 
end any of the programs, you must select them from the list and click the ‘End’ button. 
Confirm the action by clicking Okay. 
 
 
9.2.3.6 Viewing the System Information of Jiffy Client stations. 
You can view the system information of any connected Jiffy Client station. You can see, 
for instance, the name of the Operating System (OS) running on the target computer 
as well as the installed version of Jiffy Client. 
 
To view the system information of any station, select it from the list of active stations 
in the ‘Jiffy Stations’ window and click the ‘System Info’ button. A summary of the 
station’s system information will be displayed in the ‘Jiffy Client System Information’ 
window. You can update the version of Jiffy Client running on the station if you have 
already downloaded and saved any updates on the server machine. See section 1.6.2 
in Chapter 1 of this document for details.  
 
To dismiss the window, click the ‘Close’ button.  
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10 Accessing Jiffy Client stations 

10.1 Customer Tickets 
In a business environment you want access to your PCs and services restricted to only 
paying customers and authorised personnel. One of the means through which users 
can gain access is with Customer Tickets. 
 
To learn about generating and activating customer tickets, see Chapter 7 of this 
document.  

 

10.1.1 Customer Ticket Usage Scenario 
 
10.1.1.1 Using Customer Tickets to access stations. 
To log in to a station with a customer ticket, in the log in panel of Jiffy Client, make 
sure Ticket is selected as the usage option. Enter the Ticket ID and password of the 
ticket you intend to use and click the ‘Log In’ button. 
 
If the ticket is valid, you will be notified of the ticket’s current balance. To continue and 
display the Jiffy Client main window, click Okay in the notification dialogue box.  
 
 

 
 
Figure 10-1. Jiffy Client main window with an active Customer Ticket 
 
When a customer ticket is used to gain access, the left-hand side of the Jiffy Client 
window shows the usage details of the currently active ticket. The right-hand side 
provides a number of buttons you can use to control your activity. 
 

• To hide the window, click the ‘Hide Window’ button.  
 
• To merge tickets or add another ticket to the current ticket, click the ‘Add 

Ticket’ button. In the ‘Add Ticket’ dialogue box, enter the Ticket ID and 
password of the new ticket and click Okay. Only valid tickets that have never 
been used can be added to currently active tickets.  

 
• To have the Jiffy Client window pop-up to alert you when you have ten (10) 

minutes left on your ticket, check the ‘Pop-up when I have 10 minutes left’ 
checkbox. 

 
• To log off and end the current session, click the ‘Log Off’ button. 
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Jiffy Client has a timer bar that visually informs the customer of the time left on 
his/her ticket or account. When the Jiffy Client window is hidden, the timer bar gets 
positioned at the top of the screen. To log off the current session, double-click the 
logoff button located at the right end of the timer bar.  
 
 
 

 
 
Figure 10-2. Jiffy Client timer bar 
 
 
Jiffy Client also places an icon on system tray while a customer session is active. To 
quickly display the Jiffy Client window, if it is not currently visible, click this icon. You 
can also hide the Jiffy Client window, if it is currently visible, by clicking this icon. 
 
 

 
 
Figure 10-3. Jiffy icon on the system tray 
 
 

10.2 Customer Accounts 
One of the means through which users can gain access to your PCs is with Customer 
Accounts. 
 
To learn about generating and activating customer accounts, see Chapter 8 of this 
document.  
 

10.2.1 Customer Account Usage Scenario 
 
10.2.1.1 Using Customer Accounts to access stations. 
To log in to a station with a customer account, in the log in panel of Jiffy Client, make 
sure Account is selected as the usage option. Enter the Account ID and password of 
the account you intend to use and click the ‘Log In’ button. 
 
If the account is valid, you will be notified of the account’s current balance. To continue 
and display the Jiffy Client main window, click Okay in the notification dialogue box.  
 
 
 

 
 
Figure 10-4. Jiffy Client main window with an active Customer Account 
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When a customer account is used to gain access, the left-hand side of the Jiffy Client 
window shows the usage details of the currently active account. The right-hand side 
provides a number of buttons you can use to control your activity. 
 

• To hide the window, click the ‘Hide Window’ button.  
 
• To update the account information, click the ‘Update Account Info’ button. In 

the ‘Account Info’ dialogue box, you can change the account password, the 
account holder’s e-mail address and specify whether or not the holder should 
receive account holders’ reports by e-mail. You must know the correct account 
password to make any changes. Click Okay when you are done.  

 
• To have the Jiffy Client window pop-up to alert you when you have ten (10) 

minutes left on your account, check the ‘Pop-up when I have 10 minutes left’ 
checkbox. 

  
• To log off and end the current session, click the ‘Log Off’ button. 

 

 

10.3 Station Managers 
One of the means through which users can gain access to your PCs is to log in an as 
‘Station Manager’. 

 

10.3.1 Station Manager Usage Scenario 
 
10.3.1.1 Using Station Manager accounts to access stations. 
To log in to a station as Station Manager, in the log in panel of Jiffy Client, make sure 
Station Manager is selected as the usage option. Enter the user name and password of 
a user account that has the ‘Station Management’ permission and click the ‘Log In’ 
button. 
 
If the provided log in credentials are valid, you will be granted access to the Jiffy Client 
Station Management Console. 
 
To learn about managing Jiffy Client stations with the Station Management Console, 
see section 9.2.2 in Chapter 9 of this document. 
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11 Data Management 

11.1 Understanding Data Management 
As you run your café, data will be generated and stored in the database. Jiffy provides 
you a tool, which you can use to view your data via the Web Console. And since your 
database can, over time, become quite large as more data is added, you may have to 
prune it by deleting old or unwanted information from to time to time in order to 
ensure optimal performance. You may also wish to back up your data, manually or 
automatically, so as to minimise the impact of data loss. 
 
Data Manager is the tool you will use to perform all your data management tasks. 

 

11.1.1 Using Data Manager 
 
11.1.1.1 Using Data Manager to view Generated Tickets 
You can use Data Manager to view all the tickets that have ever been generated in 
your café, so long as they have not been deleted.  
 
To be able to view generated tickets using Data Manager, you must be logged in with 
an account that has the ‘View Generated Tickets’ permission. 
 
To view generated tickets, in the Jiffy Web Console tree, click the ‘Tools’ branch to 
expand it. Click the ‘Data Manager’ leaf to display its menus and then click Generated 
Tickets in the ‘Tickets’ menu. 
 
In the ‘Generated Tickets’ dialogue box, a number of options are available to you to 
help you refine your search so you can quickly find what you are looking for. 
 
From the ‘Display tickets generated’ options specify the appropriate timeframe. To 
restrict the search to the current day, for instance, choose the ‘between and’ option 
and specify the day’s date in both date fields. You may further refine your search by 
specifying the type of results you would like to see in the ‘Type’ drop-down list. To 
search for all the tickets in a particular batch of tickets, provide its Batch ID either 
partially or in full and set the type to ‘Batch with ID’. To search for a particular ticket, 
you must provide its Ticket ID in full and set the type to ‘Ticket with ID’. To see all the 
ticket batches that were generated within a particular timeframe, set the type to ‘All’.  
To see all the exhausted, deactivated, merged, expired and unused tickets that were 
generated within a given timeframe, select the appropriate type from the ‘Type’ drop-
down list and leave the ‘Batch/Ticket ID’ field blank. Click View when you are done. 
 
If you opted to view one or more ticket batches by setting the type to either ‘All’ or 
‘Batch with ID’, you can click each ticket’s Batch ID in the results pane to see the 
tickets in it. 
 
Note: 

• You can use Data Manager to view and print previously generated tickets that 
have not yet been activated. (This restriction is to ensure that you or your 
employees do not inadvertently print and sell tickets that have been previously 
generated, activated, printed and sold.) To view and print such tickets, set the 
type to either ‘All’ or ‘Batch with ID’. From the list of ticket batches in the 
‘Generated Ticket Batches’ window select the batch you want to view and print 
and click the ‘View/Print’ button. To print the tickets, right-click anywhere on 
the displayed image and click Send to Printer on the context menu. Once you 
have printed the tickets, you should activate them.  
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11.1.1.2 Using Data Manager to delete Generated Tickets 
As stated earlier, you may use Data Manager to delete generated tickets in order to 
either prune the database or remove old and/or needless tickets. 
 
To be able to delete generated tickets using Data Manager, you must be logged in with 
an account that has the ‘Delete Data using the Data Manager’ permission. This 
permission should be granted to users with some care, as it is by far the most 
important permission for two reasons: 
 

1. Useful data may be inadvertently removed 
 

2. Fraudulent employees may deliberately remove data in order to undermine 
accountability. 

 
To delete generated tickets, in the Jiffy Web Console tree, click the ‘Tools’ branch to 
expand it. Click the ‘Data Manager’ leaf to display its menus and then click Generated 
Tickets in the ‘Tickets’ menu. 
 
In the ‘Generated Tickets’ dialogue box, a number of options are available to you to 
help you easily delete or remove the relevant data. 
 
From the ‘Delete tickets generated’ options specify the appropriate timeframe. To 
restrict the data removal to the current day, for instance, choose the ‘between and’ 
option and specify the day’s date in both date fields. You may further refine your data 
removal by specifying the type of data you would like to delete in the ‘Type’ drop-down 
list. To delete all the tickets in a particular batch of tickets, you must provide its Batch 
ID in full and set the type to ‘Batch with ID’. To delete a particular ticket, you must 
provide its Ticket ID in full and set the type to ‘Ticket with ID’. You do not need to 
specify a timeframe when the type is set to either ‘Batch with ID’ or ‘Ticket with ID’. To 
delete all the ticket batches that were generated before a particular time or within a 
given timeframe, set the type to ‘All’.  
To delete all the exhausted, deactivated, merged, expired and unused tickets that were 
generated before a particular time or within a given timeframe, select the appropriate 
type from the ‘Type’ drop-down list and leave the ‘Batch/Ticket ID’ field blank. Click 
Delete when you are done and confirm the action by clicking Okay in the confirmation 
dialogue box. 
 
 
 
11.1.1.3 Using Data Manager to view Generated Accounts 
You can use Data Manager to view all the customer accounts that have ever been 
generated in your café, so long as they have not been deleted.  
 
To be able to view generated accounts using Data Manager, you must be logged in 
with an account that has the ‘View Generated Accounts’ permission. 
 
To view generated accounts, in the Jiffy Web Console tree, click the ‘Tools’ branch to 
expand it. Click the ‘Data Manager’ leaf to display its menus and then click Generated 
Accounts in the ‘Accounts’ menu. 
 
In the ‘Generated Accounts’ dialogue box, a number of options are available to you to 
help you refine your search so you can quickly find what you are looking for. 
 
From the ‘Display accounts modified’ options specify the appropriate timeframe. To 
restrict the search to the current day, for instance, choose the ‘between and’ option 
and specify the day’s date in both date fields. You may further refine your search by 
specifying the type of results you would like to see in the ‘Type’ drop-down list. To 
search for a particular account, you may provide its Account ID either partially or in full 
and set the type to ‘Account with ID’. To see all the accounts that were modified within 
a particular timeframe, set the type to ‘All’.  
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To see all the deactivated and expired accounts that were modified within a given 
timeframe, select the appropriate type from the ‘Type’ drop-down list and leave the 
‘Account ID’ field blank. Click View when you are done. 
 
In the ‘Generated Accounts’ window, you can click each account’s Account ID in the 
results pane to see its details. 
 
Note: 

• Since customer accounts are long-lived, i.e. unlike customer tickets, they 
continue to exist as long as their holders want them to be active and may, 
depending on usage, continually go through a cycle of deactivation and 
activation after generation. Therefore, to make it easier for you to search for 
customer accounts, Jiffy uses the date that the customer account was last 
modified instead of the date it was generated. Accounts are modified when they 
are generated, deactivated deliberately (or by Jiffy upon expiration) and when 
they are activated again. 

 
 
11.1.1.4 Using Data Manager to delete Generated Accounts 
To be able to delete generated accounts using Data Manager, you must be logged in 
with an account that has the ‘Delete Data using the Data Manager’ permission. This 
permission should be granted to users with some care, see section 11.1.1.2 above for 
reasons why.  
 
To delete generated accounts, in the Jiffy Web Console tree, click the ‘Tools’ branch to 
expand it. Click the ‘Data Manager’ leaf to display its menus and then click Generated 
Accounts in the ‘Accounts’ menu. 
 
In the ‘Generated Accounts’ dialogue box, a number of options are available to you to 
help you easily delete or remove the relevant data. 
 
From the ‘Delete accounts generated’ options specify the appropriate timeframe. To 
restrict the data removal to the current day, for instance, choose the ‘between and’ 
option and specify the day’s date in both date fields. You may further refine your data 
removal by specifying the type of data you would like to delete in the ‘Type’ drop-down 
list. To delete a particular account, you must provide its Account ID in full and set the 
type to ‘Account with ID’. You do not need to specify a timeframe when the type is set 
to ‘Account with ID’. To delete all the accounts that were modified before a particular 
time or within a given timeframe, set the type to ‘All’.  
To delete all the deactivated and expired accounts that were modified before a 
particular time or within a given timeframe, select the appropriate type from the ‘Type’ 
drop-down list and leave the ‘Account ID’ field blank. Click Delete when you are done 
and confirm the action by clicking Okay in the confirmation dialogue box. 
 
 
11.1.1.5 Using Data Manager to view Activity Logs 
All the activity in your café, including customer account loyalty realisation (when 
customers receive loyalty units), printing, payments made into customer accounts, 
Jiffy Client station uptimes and ticket/account usage, is logged so you can view the 
data at anytime. 
 
To be able to view activity logs with Data Manager, you must be logged in with an 
account that has the ‘View Activity Logs’ permission. 
 
To view activity logs, in the Jiffy Web Console tree, click the ‘Tools’ branch to expand 
it. Click the ‘Data Manager’ leaf to display its menus and then click Logs in the ‘Activity’ 
menu. 
 
In the ‘Activity Logs’ dialogue box, a number of options are available to you to help 
you refine your search so you can quickly find what you are looking for. 
 
From the ‘Display logs generated’ options specify the appropriate timeframe. To 
restrict the search to the current day, for instance, choose the ‘between and’ option 
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and specify the day’s date in both date fields. You may further refine your search by 
specifying the type of results you would like to see in the ‘Type’ drop-down list. 
 
You can view detailed logs of customer account loyalty realisation by setting the search 
type to Account Loyalty. To do so for a particular customer account, provide its 
Account ID in full. To view the account loyalty logs for all the accounts, leave the ID 
field blank. Specify the desired timeframe and click View when you are done. In the 
‘Account Loyalty Logs - Summary’ window, you can click each account’s Account ID in 
the results pane to see detailed account loyalty logs for the account. 
 
You can view detailed logs of payments made into customer accounts by setting the 
search type to Account Payments. To do so for a particular customer account, provide 
its Account ID in full. To view the payment logs for all the accounts, leave the ID field 
blank. Specify the desired timeframe and click View when you are done. In the 
‘Account Payment Logs - Summary’ window, you can click each account’s Account ID in 
the results pane to see detailed account payment logs for the account. 
 
You can view detailed logs of printing activity by setting the search type to Printing. To 
do so for a particular customer account or customer ticket, provide its Account ID or 
Ticket ID in full. To view printing activity logs for all the accounts and tickets, leave the 
ID field blank. Specify the desired timeframe and click View when you are done. In the 
‘Printing Logs - Summary’ window, you can click each account’s Account ID or ticket’s 
Ticket ID, in the results pane to see detailed printing activity logs for the account or 
ticket. 
 
You can view detailed logs of Jiffy Client station uptimes by setting the search type to 
Station Uptimes. To do so for a particular station, provide its host name (in the same 
case as it appears in the list active stations – uppercase or lowercase) in full. To view 
station uptime logs for all the stations, leave the ID field blank. Specify the desired 
timeframe and click View when you are done. In the ‘Station Uptime Logs - Summary’ 
window, you can click each station’s host name, in the results pane to see detailed 
station uptime logs for the station. 
 
You can view detailed logs of station usage by setting the search type to 
Ticket/Account Usage. To do so for a particular customer account or customer ticket, 
provide its Account ID or Ticket ID in full. To view station usage logs for all the 
accounts and tickets, leave the ID field blank. Specify the desired timeframe and click 
View when you are done. In the ‘Usage Logs - Summary’ window, you can click each 
account’s Account ID or ticket’s Ticket ID, in the results pane to see detailed usage 
logs for the account or ticket. 
 
 
11.1.1.6 Using Data Manager to delete Activity Logs 
To be able to delete activity logs using Data Manager, you must be logged in with an 
account that has the ‘Delete Data using the Data Manager’ permission. This permission 
should be granted to users with some care, see section 11.1.1.2 above for reasons 
why.  
 
To delete activity logs, in the Jiffy Web Console tree, click the ‘Tools’ branch to expand 
it. Click the ‘Data Manager’ leaf to display its menus and then click Logs in the ‘Activity’ 
menu. 
 
In the ‘Activity Logs’ dialogue box, a number of options are available to you to help 
you easily delete or remove the relevant data. 
 
From the ‘Delete logs generated’ options specify the appropriate timeframe. To restrict 
the data removal to the current day, for instance, choose the ‘between and’ option and 
specify the day’s date in both date fields. You may further refine your data removal by 
specifying the type of data you would like to delete in the ‘Type’ drop-down list. To 
delete data for a particular account, ticket or station, you must provide its Account ID, 
Ticket ID or host name in full and set the appropriate type and timeframe. To delete 
data for all the accounts, tickets or stations generated before a particular time or 
within a given timeframe, leave the ID field blank.  
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Click Delete when you are done and confirm the action by clicking Okay in the 
confirmation dialogue box. 
 
 

11.1.2 Using the Database Assistant 
The ‘Database Assistant’ is a Data Manager tool that you can use to: 
 

• Manually backup and restore your data 
 
• Easily define a schedule for backing up your data automatically 

 
To be able to use the ‘Database Assistant’, you must be logged in with an account that 
has the ‘Use the Database Assistant, Backup/Restore data’ permission.  
 
 
11.1.2.1 Using the Database Assistant to manually backup data 
To manually backup the database, in the Jiffy Web Console tree, click the ‘Tools’ 
branch to expand it. Click the ‘Data Manager’ leaf to display its menus and then click 
Backup in the ‘Database Assistant’ menu. 
 
In the ‘Manual Data Backup’ dialogue box, enter the path of the directory in which you 
would like to backup the data, e.g. c:\databackup. This directory may exist or be 
created on another drive but, for performance reasons, the drive should be installed on 
the same machine as the Jiffy Application Server is running on. Click Okay to initiate 
the database backup and wait for a confirmation. Click Close to dismiss the dialogue 
box. 
 
 
11.1.2.2 Using the Database Assistant to manually restore data 
To manually restore the database, in the Jiffy Web Console tree, click the ‘Tools’ 
branch to expand it. Click the ‘Data Manager’ leaf to display its menus and then click 
Restore in the ‘Database Assistant’ menu. 
 
In the ‘Restore Data’ dialogue box, the directory path that was used for the last 
database backup will be in the ‘Location’ field. If it is not or is incorrect, enter the 
correct path of the directory where you backed up your data, e.g. c:\databackup. Click 
Okay to initiate the database restoration and wait for a confirmation. Click Close to 
dismiss the dialogue box. 
 
Note: 

• Whenever you restore your database from a previous backup, you stand a 
chance of losing some data unless no changes were made to your data within 
the period you last backed up your database and restored it. For instance, some 
customers may have exhausted their tickets while some customer account 
holders may have changed their passwords. These changes would be lost if you 
restored data from an earlier backup you made before the changes took place. 
However, being able to restore any data is be better than nothing at all, 
especially in the face of complete data loss. However, a very recent backup 
should be used. 

 
 
11.1.2.3 Defining a Schedule for Automatic Database Backup 
You can easily define a schedule to help you automatically backup your database 
instead of having to do it manually. Currently, you can only define a schedule for daily 
backups – the database backup will occur once everyday at a particular time. 
 
To define a schedule for automatic database backup, in the Jiffy Web Console tree, 
click the ‘Tools’ branch to expand it. Click the ‘Data Manager’ leaf to display its menus 
and then click Auto-backup in the ‘Database Assistant’ menu. 
 
In the ‘Daily Data Auto-Backup’ dialogue box, specify whether or not you want to 
enable automatic database backups. Enter the path of the directory in which you would 
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like to automatically backup the data, e.g. c:\databackup. This directory may exist or 
be created on another drive but, for performance reasons, the drive should be installed 
on the same machine as the Jiffy Application Server is running on. Select the time at 
which the database backup should occur. Click Okay to define the schedule and wait 
for a confirmation. Click Close to dismiss the dialogue box. 
 
Note: 

• Anytime you wish to do so, you can change the backup location or the time at 
which the backup should automatically occur. 

 
• If for any reason the database is not automatically backed up on schedule (for 

instance, you may not have opened for business on a particular day and the 
Jiffy Application Server may not have been running as a result), you may edit 
the schedule to specify a different time. After the database has been backed up, 
you can revert to the old schedule. 
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12 Reports 

12.1 Understanding Reports 
While Data Manager provides you with detailed logs of all the activities in your café, 
Jiffy reports summarise the details and furnish you with the really important pieces of 
information.  
 
Currently, Jiffy provides seven different reports covering: 
 

1. Generated Tickets – shows how much to expect from the sale of customer 
tickets. 

 
2. Used Tickets – shows how much was actually realised from the sale of customer 

tickets 
 
3. Account Payments – shows how much was paid into customer accounts 

 
4. Account Loyalty – shows how much you have given away to your customers by 

way of reward for customer loyalty 
 

5. Station Usage – shows how long customer tickets, customer accounts and 
administrative personnel spent on your Jiffy Client stations 

 
6. Printing – shows how much was realised from printing activity 

 
7. Station Uptimes – shows how much time your stations were up for 

 
You can log in to the Jiffy Web Console to create/view these reports yourself (if you are 
authorised to do so) or have them sent to your mailbox via e-mail on schedule. Also 
before using Data Manager to prune your database by deleting old or needless data, 
you may want to create reports covering the relevant periods and then save them. 
After removing all the needless data you would have reports that capture a summary 
of the deleted data. This ensures that you retain useful and relevant business 
information while reducing the size of the database to ensure optimal performance at 
all times. 
 
Customer Account holders will be able to receive reports in their mailboxes if you 
enable this feature for your café and for each interested customer in his/her account 
profile. 
 
Finally, reports can also be sent to interested parties who subscribe to specific reports.  
 
 

12.1.1 Creating and Managing Reports 
 
12.1.1.1 Creating and Saving a New Report 
To be able to create, view and save reports, you must be logged in with an account 
that has the ‘Create and Save Reports’ permission. 
 
To create a new report, in the Jiffy Web Console tree, click the ‘Tools’ branch to expand 
it. Click the ‘Reports’ leaf to display its menus and then click New Report in the ‘View’ 
menu. 
 
In the ‘New Report’ dialogue box, a number of options are available to you to help you 
quickly create the needed report(s). 
 
To create a report for the current day (a daily report from 00:00:00 AM to the current 
time), select Daily from the ‘Period’ drop-down list. To create a report for the current 
week (a weekly report from Sunday, 00:00:00 AM to the current day and time), select 
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Weekly from the ‘Period’ drop-down list. To create a report for the current month (a 
monthly report from the first day of the month, 00:00:00 AM to the current day and 
time), select Monthly from the ‘Period’ drop-down list. To specify a given timeframe, 
select Other from the ‘Period’ drop-down list and enter the dates in the ‘From’ and ‘To’ 
fields. Specify the type of report you that want to create and click the ‘Generate 
Report’ button. 
 
When the report has been generated, you can choose to save it or print it. To save the 
report, click the ‘Save’ link and wait for a confirmation. To print the report, click the 
‘Print’ link. Both links are located at the top-right-hand corner of the report window. 
 
Note: 

• For the weekly report, it is assumed that the first day of the week is Sunday. 
 
 
12.1.1.2 Viewing Saved Reports 
You can view the reports that have been previously saved, so long as they have not 
been deleted. However, you need to know what periods the saved reports cover in 
order to locate them. 
 
To be able to view saved reports, you must be logged in with an account that has the 
‘View Saved Reports’ permission. 
 
To view a saved report, in the Jiffy Web Console tree, click the ‘Tools’ branch to 
expand it. Click the ‘Reports’ leaf to display its menus and then click Archived Reports 
in the ‘View’ menu. 
 
In the ‘Archived Reports’ dialogue box, a number of options are available to you to 
help you quickly find the needed report(s). 
 
From the ‘Display reports for the period’ options specify the appropriate timeframe 
covered by the report(s) you are looking for. To restrict the search to the current day, 
for instance, choose the ‘between and’ option and specify the day’s date in both date 
fields. You may further refine your search by specifying the type of archived reports 
you would like to see in the ‘Type’ drop-down list. 
 
To see the archived reports for all report types within a given timeframe, select ‘All’ 
from the ‘Type’ drop-down list. To see archived reports for a particular report type, 
select the appropriate type from the ‘Type’ drop-down list. Click View when you are 
done. Click Close to dismiss the dialogue box. 
 
Note: 

• You can only print archived reports. 
 
 
12.1.1.3 Deleting Saved Reports 
You can delete previously saved reports, you however need to know what periods the 
saved reports cover in order to delete them. 
 
To be able to delete saved reports, you must be logged in with an account that has the 
‘Delete Saved Reports’ permission.  
 
To delete saved reports, in the Jiffy Web Console tree, click the ‘Tools’ branch to 
expand it. Click the ‘Reports’ leaf to display its menus and then click Archived Reports 
in the ‘View’ menu. 
 
In the ‘Archived Reports’ dialogue box, a number of options are available to you to 
help you easily delete or remove the relevant archived reports. 
 
From the ‘Delete saved reports for the period’ options specify the appropriate 
timeframe. To restrict the report removal to the current day, for instance, choose the 
‘between and’ option and specify the day’s date in both date fields. You may further 
refine your removal of archived reports by specifying the type of saved reports you 
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would like to delete in the ‘Type’ drop-down list. To delete all types of saved reports, 
set the type to ‘All’. To delete a particular report type, select the appropriate type from 
the ‘Type’ drop-down list. Specify the timeframe or period covered by the report. 
 
Click Delete when you are done and confirm the action by clicking Okay in the 
confirmation dialogue box. 
 
 

12.1.2 Using the Report Assistant 
The ‘Report Assistant’ is a reporting tool that you can use to: 
 

• Define a schedule for sending reports to customer account holders via e-mail 
 
• Define a schedule for sending reports to the e-mail addresses of interested 

parties who subscribe to specific reports. 
 
To be able to use the ‘Report Assistant’, you must be logged in with an account that 
has the ‘Use the Report Assistant, View and Manage Report Subscribers’ permission.  
 
 
12.1.2.1 Defining a Schedule for Sending Reports to Account Holders 
You can define a schedule for sending reports via e-mail to customer account holders 
for whom you have enabled this feature in their account profiles. You can choose to 
send the reports daily, weekly or monthly.  
 
To define a schedule for sending reports to account holders, in the Jiffy Web Console 
tree, click the ‘Tools’ branch to expand it. Click the ‘Reports’ leaf to display its menus 
and then click Account Holders in the ‘Report Assistant’ menu. 
 
In the ‘Account Holders’ Report Schedule’ dialogue box, specify whether or not you 
want to enable the sending of reports to account holders. From the ‘Frequency’ 
options, choose the desired frequency. Finally, specify the time. Click Okay to create 
the schedule and wait for a confirmation. Click Close to dismiss the dialogue box. 
 
Note: 

• If for any reason the reports are not sent on schedule (for instance, you may 
not have opened for business on a particular day and the Jiffy Application 
Server may not have been running as a result), you may edit the schedule to 
specify a different time. After the reports are sent, you can revert to the old 
schedule. 

 
• The reports are sent in HTML format. Most e-mail clients (including web-based 

ones) can display messages sent in this format. 
 
 
12.1.2.2 Defining a Schedule for Sending Reports to Report Subscribers 
You can define a schedule to sending reports via e-mail to a list of interested parties 
who subscribe to specific reports. These subscribers may never have to log in to the 
Jiffy Web Console to create and view the reports one by one because they will receive 
them (in one e-mail message) directly in their mailboxes on schedule. You can choose 
to send the reports daily, weekly or monthly.  
 
To define a schedule for sending reports to report subscribers, in the Jiffy Web Console 
tree, click the ‘Tools’ branch to expand it. Click the ‘Reports’ leaf to display its menus 
and then click Report Subscribers in the ‘Report Assistant’ menu. 
 
In the ‘Subscribers’ Report Schedule’ dialogue box, specify whether or not you want to 
enable the sending of reports to report subscribers. From the ‘Frequency’ options, 
choose the desired frequency. Finally, specify the time. Click Okay to create the 
schedule and wait for a confirmation. Click Close to dismiss the dialogue box. 
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Note: 
• If for any reason the reports are not sent on schedule (for instance, you may 

not have opened for business on a particular day and the Jiffy Application 
Server may not have been running as a result), you may edit the schedule to 
specify a different time. After the reports are sent, you can revert to the old 
schedule. 

 
• The reports are sent in HTML format. Most e-mail clients (including web-based 

ones) can display messages sent in this format. 
 
 
12.1.2.3 Managing Report Subscribers 
To view and add/remove subscribers to/from the list of report subscribers, in the Jiffy 
Web Console tree, click the ‘Tools’ branch to expand it. Click the ‘Reports’ leaf to 
display its menus and then click Report Subscribers in the ‘View’ menu. 
 
The ‘Registered Report Subscribers’ window will display a list of e-mail addresses 
belonging to the currently registered report subscribers. This list will be empty if you 
have not yet defined any report subscribers. 
 
To add a new report subscriber to the list, click the ‘New’ button. In the ‘Report 
Subscriber’ dialogue box, enter the e-mail address of the subscriber and check each 
checkbox corresponding to each report that the subscriber would like to receive. The 
different reports will be combined into a single e-mail message and sent to the 
provided e-mail address. A subscriber must subscribe to at least one report. When you 
are done, click Okay to add the new subscriber to the list of registered report 
subscribers. Click Close to dismiss the dialogue box. 
 
To view the report(s) that each report subscriber has subscribed to, click the 
subscriber’s e-mail address in the list. In the ‘Report Subscriber’ dialogue box, you can 
edit the subscriber’s e-mail address and specify additional (or remove existing) reports 
for the subscriber. 
 
To remove one or more subscribers from the list of registered report subscribers (so 
that they will no longer receive reports), select the subscribers’ e-mail addresses from 
the list and click the ‘Delete’ button. Confirm the action by clicking Okay in the 
confirmation dialogue box. 
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13 The Jiffy Proxy Server and Jiffy Web Client 

13.1 About the Jiffy Proxy Server 
The Jiffy Application Server includes a SOCKS-based proxy server that supports both 
versions 4 and 5 of the SOCKS protocol. You may use this proxy server if you wish to 
monitor and bill customers who bring their own laptops or computers to your café as 
well as block access to certain sites.  
 
The primary purpose of the Jiffy Proxy server is to monitor and control access to the 
Internet by ensuring that all your customers pay for your services especially when they 
choose to use computers that do not have Jiffy Client installed on them e.g., their own 
computers. You may also use the Jiffy Proxy server if you do not have a proxy server 
available. However, note that the Jiffy Proxy server does not provide any caching 
services. If you need to have caching, you would have to install a proxy server that 
provides it and have the Jiffy Proxy server use it as a Secondary Proxy server. All the 
requests from web browsers and other SOCKS-aware Internet-based client applications 
will go through the Jiffy Proxy server first, after which they will be routed through the 
Secondary Proxy server. 

 

13.1.1 Configuring and managing the Jiffy Proxy Server 
 
13.1.1.1 Setting the Jiffy Proxy Server Options 
To be able to configure the Jiffy Proxy Server, you must be logged in with an account 
that has the ‘Configure Site Options’ permission. To do so, in the Jiffy Web Console 
tree, click the ‘Application Services’ branch to expand it. Click the ‘Proxy Server’ leaf to 
display its menus and then click Jiffy Server Proxy Options in the ‘Setup’ menu. 
 
In the ‘Jiffy Proxy Server Options’ dialogue box, to enable the Jiffy Proxy server, select 
Yes. To disable it, select No. Enter the port number in the Port text field. The default 
port number is 1080. If it is in use by some other application, e.g. another proxy 
server, change it to any other value (typically between 0 and 65535). 
 
In the IP Addresses allowed to access Proxy field, provide an entry of the IP addresses 
that are allowed to access the Jiffy Proxy server. To provide a range of addresses, for 
example, enter 192.168.0.1:192.168.0.50. This may represent the entire range of 
valid IP addresses in your café. To add another range or include one or more IP 
addresses to the list, separate the values with a semi-colon (;), e.g.: 
192.168.0.1:192.168.0.50;192.168.0.60:192.168.0.80;192.168.0.55;192.168.0.90. 
 
From the Max log file size field select a suitable value for the maximum size of the Jiffy 
Proxy Server log file. The log file will be over-written with new content once the size of 
the file reaches this value. 
 
You can change the Jiffy Web Client Welcome Image to suit your needs. Click the 
Upload Image button to upload a new image. Click the View Image link to view the 
current welcome image. 
 
To enable site blocking, select Yes. To disable it, select No. 
 
If you have another proxy server that implements features that the Jiffy Proxy server 
lacks or your ISP requires that you go through its own proxy server, you should enter 
its details in the Secondary Proxy Server field in the following format: 
hostname_or_ip:port_number:username:password, where hostname_or_ip is either 
the host name or IP address of the proxy server machine, port_number the proxy 
server’s port number and username and password are the username and password 
required for authentication. Make sure you separate the values with a colon (:) as 
shown above. The username and password values may be omitted if they are not 
required. However, in order to support SOCKS v4 clients, ':user” will be appended to 
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the entry if you do not provide both a username and password. Note that the 
Secondary Proxy Server must support either version 4 or 5 of the SOCKS protocol. 
 
13.1.1.2 Blocking access to certain websites 
The Jiffy Proxy server can block access to websites that you specify if you have 
enabled the site blocking option.  
 
To be able to manage the list of websites that the Jiffy Proxy server should block, you 
must be logged in with an account that has the ‘Configure Site Options’ permission. To 
do so, in the Jiffy Web Console tree, click the ‘Application Services’ branch to expand 
it. Click the ‘Proxy Server’ leaf to display its menus and then click Blocked Sites in the 
‘Setup’ menu. 
 
In the ‘Blocked Sites’ window, a list of sites that have been blocked will be displayed. 
This list will be empty if you have not specified any sites to be blocked. To add one or 
more websites to the list, click the New… button. In the Blocked Sites dialogue box, 
enter a list of sites that you wish to block. Note that to make it possible for the Jiffy 
Proxy Server to block access to all hosts on a particular site or domain (which, usually 
is the desired goal), you should simply enter the name of the domain without the 
domain suffix. For instance, to block access to http://www.yahoo.com, simply enter 
yahoo. As a result, the Jiffy Proxy Server will also block access to 
http://mail.yahoo.com, http://mail.yahoo.co.uk, etc. You can enter multiple sites at 
once but separate them with a comma (,). To save the new entries, click the Save 
button. When you are done, click the Close button. 
 
To remove one or more websites from the list of blocked sites, select them from the 
list and click the Delete button. Confirm the action by clicking OK. You may click the 
Refresh button to view changes made to the list. 
 
13.1.1.3 Managing the Jiffy Proxy Server 
The Jiffy Proxy Server, if it is enabled, starts up whenever the Jiffy Server starts up. 
Therefore, stopping the Jiffy Server will also stop the Jiffy Proxy Server. However, you 
can start or stop the Jiffy Proxy Server independent of the Jiffy Server. To be able to 
stop, start or view the status of the Jiffy Proxy Server, you must log in to the Jiffy Web 
Console with a user account that has the ‘Manage the Jiffy Proxy (Stop/Start, View 
Status)’ permission.  
 
In order to manage the Jiffy Proxy Server, in the Jiffy Web Console tree, click the 
‘Application Services’ branch to expand it. Click the ‘Proxy Server’ leaf to display its 
menus. To stop the Jiffy Proxy Server, if it is running, click Stop under the Start/Stop 
menu. Confirm the action by clicking OK. To start the Jiffy Proxy Server, if it is not 
already running, click Start under the Start/Stop menu. To view the status of the Jiffy 
Proxy Server, click Status under the View menu. 
 
13.1.1.4 Viewing the Jiffy Proxy Server logs 
You can view the logs that the Jiffy Proxy Server generates at anytime. To be able to 
do this, you must log in to the Jiffy Web Console with a user account that has the ‘View 
Jiffy Server Application Logs’ permission. 
 
In order to view the Jiffy Proxy Server logs, in the Jiffy Web Console tree, click the 
‘Application Services’ branch to expand it. Click the ‘Proxy Server’ leaf to display its 
menus. Click Jiffy Proxy Server Logs under the View menu to display the logs. 
 
 

13.2 About the Jiffy Web Client  
The Jiffy Web Client enables you to monitor and bill customers who do not have the 
Jiffy Client software installed on their computers but wish to gain access to your 
services – Internet and print services. To be able to use the Jiffy Web Client for this 
purpose, you must enable and configure the Jiffy Proxy Server appropriately. 
 
In order to gain access, customers would have to provide either a valid Ticket ID or a 
customer Account ID and password. The Jiffy Web Client can be accessed on your LAN 
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with a web browser via a URL like this: http://host_ipaddress:port_number/webclient; 
where host_ipaddress refers to the IP address of the Jiffy Server machine and 
port_number the port number of the Jiffy Web Console. 
 
 

13.2.1 Gaining access to the Jiffy Web Client 
 
13.2.1.1 Configuring the web browser for use with the Jiffy Web Client 
To configure Internet Explorer, click Internet Options… under the Tools menu. Click the 
Connections tab and then the LAN Settings… button. Make sure that both the Use a 
proxy server for your LAN and Bypass proxy server for local address checkboxes are 
checked otherwise users will not be able to access the Jiffy Proxy Server in the first 
place. Click the Advanced… button. In the Socks field of the Proxy Settings dialogue 
box, enter the IP address of the LAN interface of the Jiffy Server machine and enter 
the port number of the Jiffy Proxy Server, leave the other fields blank as shown in 
Figure 13-1 below. 
 
When you are done click OK. The procedure to configure your browser of choice (if you 
are not using Internet Explorer) will not be too different from that described above. 
Remember to configure your browser to bypass the Jiffy Proxy Server for local 
addresses. 
 

 
 
Figure 13-1. Internet Explorer Proxy Settings 
 
 
13.2.1.2 Using the Jiffy Web Client 
A properly configured web browser is used to access the Jiffy Web Client via a URL like 
this: http://host_ipaddress:port_number/webclient; where host_ipaddress refers to 
the IP Address of the Jiffy Server machine and port_number the port number of the 
Jiffy Web Console. 
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Figure 13-2. Jiffy Web Client Login Page 
 
 
On the Jiffy Web Client Login page, to log in with a valid Ticket, select Ticket and enter 
the Ticket ID and password in the Enter ID and Password fields respectively. To log in 
with a valid customer Account, select Account and enter the Account ID and password 
in the Enter ID and Password fields respectively. Click the Login button when you are 
done. 
 
 

 
 
Figure 13-2. The Jiffy Web Client Panel 
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The Jiffy Web Client Panel displays the status of the currently logged in customer’s 
Ticket or Account. Note that this page can be closed without the customer losing his or 
her connection – billing will continue whether or not this page is left displayed after the 
customer has been successfully authenticated. To display this page again, simply visit 
the original URL: http://host_ipaddress:port_number/webclient. If the customer’s 
Ticket or Account is still valid, this page will be displayed otherwise the Jiffy Web Client 
Login page will be displayed instead. 
 
When a customer wishes to disconnect, the customer must click the Log Off button, if 
not, the Jiffy Server will continue to bill the customer’s Ticket or Account. 
 
To merge tickets or add a valid Ticket to the currently logged in customer’s Ticket, click 
the Add Ticket button. In the Add Ticket dialogue box, enter the Ticket ID and 
password of the new ticket and Click Okay. To dismiss the dialogue box, click Close. 
Note that the Add Ticket button is not usable if a customer Account is used to log in. 
 
To update the customer’s account information e.g. to change the customer’s account 
password, click the Update Account Info button. In the Account Info dialogue box, 
make the appropriate changes and click Okay. To dismiss the dialogue box, click Close. 
Note that the Update Account Info button is not usable if a Ticket is used to log in. 
 
The Jiffy Web Client Panel is automatically refreshed every 60 seconds. To refresh it 
manually at anytime, click the Refresh button. 
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14 Troubleshooting FAQs 

14.1 Jiffy Client 
 
(Q) What do I do when a Jiffy Client station cannot connect to Jiffy Server? 

 
(A) This could happen if the Jiffy Application Server is not currently available or the 

Jiffy Server component has been stopped or could not start due to some error. 
If this is the case, simply starting the ‘Jiffy Application Server’ service or Jiffy 
Server and ensuring that there are no network configuration errors, will enable 
the stations to successfully connect to the server.  
 
To check whether Jiffy Server is running, on any other computer on your LAN, 
enter the following at the command prompt: 
 
C:\>telnet <hostname> <port_number> 
 
Where <hostname> and <port_number> refer to the name of your server 
machine and the port number specified for Jiffy Server respectively. If you 
cannot open a telnet session, it means that Jiffy Server is not running on the 
server machine. If you can open a telnet session but the stations cannot access 
Jiffy Server, it means that you may have specified a port number that is in use 
by another application for Jiffy Server. You must specify a vacant port number 
for Jiffy Server to use. 
 
Also ensure that no firewall has been installed on the server machine. If there is 
a firewall, make sure you configure it to allow access to the server via the port 
number specified for Jiffy Server. The default Jiffy Server port number is 5555. 
 
Finally ensure that any Jiffy Client station that currently cannot connect to Jiffy 
Server is itself accessible from your LAN. To do this, enter the following at the 
command prompt: 
 
C:\>ping <hostname> or <ip_address> 
 
Where <hostname> and <ip_address> refer to the name of the station and its 
IP Address respectively. 
 
If you cannot access the station, check its LAN cable, network adapter and/or 
network configuration. 
 
Note also that a Jiffy Client station will not be able to connect to the server if 
the Jiffy Server network interface properties were not correctly specified either 
during setup or via the Station Management Console. Since Jiffy does not 
provide a backdoor, you may have to completely uninstall and reinstall Jiffy 
Client on the station, making sure to specify the correct server properties 
namely: the host name of the server machine and the port number Jiffy Server 
is listening on during the installation process. 
 
To uninstall Jiffy Client, turn off the station using the power button. Turn it on 
again, and to ensure that Jiffy Client does not start, start Microsoft Windows in 
Safe Mode with an account that has Administrative privileges on the computer. 
If you log in to Windows with an account that does not have Administrative 
privileges, you will not be able to successfully uninstall Jiffy Client.  
 
When Windows starts up in Safe Mode, uninstall Jiffy Client in the usual 
manner. Restart the computer normally and reinstall Jiffy Client. If you 
correctly provided the Jiffy Server network interface properties, the station will 
be able to connect to the server. 
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 (Q) Why are customers not charged automatically when they use my 
printers? 
 

(A) You may not have enabled Print Monitoring and Billing for your café. To do so, 
refer to sections 5.3.1.2 and 5.3.1.3 in Chapter 5 of this document. However, 
Print Monitoring and Billing only works when you have installed your printers’ 
drivers in the recommended manner on each Jiffy Client station. Please see 
sections 1.4.2.3 and 1.4.2.4 in Chapter 1 of this document for detailed 
instructions on how to properly install your printers’ drivers for reliable print 
monitoring and billing. 
  

(Q) Why is it that when a print job is sent to a printer, Jiffy reports that the 
printing charge could not be obtained? 
 

(A) If you have enabled Print Monitoring and Billing for your café, Jiffy will not be 
able to obtain the correct charge for the printer if you have not provided a 
charge for it. Note that Jiffy will not allow any print jobs to go to your printer(s) 
if it cannot determine the correct charge. This protects you as well as your 
customers. To learn how to specify printing charges for your printers, refer to 
sections 5.3.1.2 and 5.3.1.3 in Chapter 5 of this document.  
 
Important 
 
If you have a laser printer that has a PostScript driver (such drivers usually 
have PS in their names), you may experience this problem when using certain 
applications e.g. Adobe Acrobat. In this case, Jiffy may report that the printing 
charge could not be obtained for the printer. This is so because the driver 
initially sets the number of pages to zero (0) and as such Jiffy will obtain a total 
charge of 0.00 units for the print job. To correct this behaviour, avoid using 
PostScript drivers. Try using another kind of driver e.g. a Printer Control 
Language (PCL) driver provided for the printer instead – these drivers usually 
have PCL in their names. Many laser printer manufacturers provide other kinds 
of drivers as well. Test your applications against the driver(s) you intend to use 
to make sure everything works well. 
 
If you experience this while using Microsoft Word in particular even though you 
have specified printing charges for your printers, check to make sure that 
Collate is enabled before the print job is sent to the printer. Enable Collate by 
checking the Collate checkbox in the Print dialogue box. If this does not solve 
the problem, restart the station, either from the station using the Station 
Management Console or from the Jiffy Web Console. 
 
Jiffy Client v1.3.1 (and above) contains a workaround to ensure that the correct 
number of print job copies is obtained from Microsoft Word. If Jiffy is running in 
Auto mode with a user account that has ‘User’ privileges in Microsoft Windows, 
you need to restart the station at least once after Jiffy has been configured to 
use the account so that the changes made by Jiffy can take effect. Afterwards, 
these changes will stay in effect and Jiffy will be able to obtain the correct 
printing charge(s). 
 
Note that these changes are undone each time you Stop Jiffy (using the Station 
Management Console) and subsequently restart the station. When this 
happens, the next time you start Jiffy manually and specify a user account that 
has ‘User’ privileges, you must go over the process described above. However, 
if you simply Shutdown or Reboot the machine from the Station Management 
Console or the Jiffy Web Console, the changes will still be in effect the next time 
the station starts up. 
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(Q) How do I enable the Jiffy Client login panel when it is disabled and the 
mouse cursor enters the wait state? 
 

(A) The Jiffy Client login panel becomes temporarily disabled with the mouse cursor 
entering the wait state whenever a customer or a user with the ‘Station 
Management’ permission attempts to log in to a station. The panel returns to 
the normal state after the login credentials have been verified – whether the 
customer or user was granted access or not.  
 
However, the verification process may take too long either because of 
temporary network failure or some other reason. If this happens, the login 
panel will become inaccessible and nobody will be able to login. To get the 
panel back to the normal state, Lock/Unlock the station, using the Jiffy Web 
Console as described in section 9.2.3.4 in Chapter 9 of this document. 
  

 
 

14.2 Jiffy Application Server 
 
(Q) I have installed the Jiffy Application Server, but my browser cannot 

access the Jiffy Web Console, why? 
 

(A) If your browser has been configured to use a proxy server, you may need to 
bypass it to be able to access the Jiffy Web Console using the server machine’s 
host name in the URL. For Internet Explorer, open the Internet Options dialogue 
box, check the ‘Bypass proxy server for local addresses’ checkbox in LAN 
Settings under the Connections tab. Most other browses allow you to bypass a 
proxy server. Consult your browser’s documentation for details. If you have 
done this and you still cannot access the Jiffy Web Console, check to make sure 
that the Jiffy Application Server is running.  
 
To find out whether the Jiffy Application Server is running and that the Jiffy 
Web Console is accessible, at the command prompt, run the following command 
from any computer on your LAN: 
 
C:\>telnet <hostname> <port_number> 
 
Where <hostname> and <port_number> refer to the name of your server 
machine and the port number specified for the Web Console respectively. 
 
You will be able to open a telnet session to the Jiffy Web Console if you used 
the correct port number. If you cannot open a telnet session, even after 
specifying the correct port number, make sure that the ‘Jiffy Application Server’ 
service is running on the specified machine.  
 
Also ensure that no firewall has been installed on the server machine. If there is 
a firewall, make sure you configure it to allow access to the server via the port 
number specified for the Jiffy Web Console. The default Jiffy Web Console port 
number is 8080. 
 
Finally ensure that the server itself is accessible from your LAN. To do this, 
enter the following at the command prompt: 
 
C:\>ping <hostname> or <ip_address> 
 
Where <hostname> and <ip_address> refer to the name of the server machine 
and its IP Address respectively. 
 
If you cannot access the server, check its LAN cable, network adapter and/or 
network configuration. 
 
If the ‘Jiffy Application Server’ service is not running, start it. Once it starts up 
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successfully, attempt to access the Jiffy Web Console again. If you cannot open 
it in your web browser, stop the ‘Jiffy Application Server’ service and run the 
telnet command again. If you can open a telnet session, it means that another 
application is using the port number that you chose for the Web Console. You 
must specify a vacant port number for use with the Jiffy Web Console. 
 
If the ‘Jiffy Application Server’ service fails to start, make sure that the version 
of the Java Runtime Environment (JRE) you are using is 1.5/5.0 or higher. 
  
To solve any of these issues, stop the ‘Jiffy Application Server’ service, if it is 
running; uninstall and reinstall the Jiffy Application Server, making sure to 
provide the correct version of the JRE and/or a vacant port number for the Web 
Console. Also, before uninstalling the Jiffy Application Server, make sure that 
you have backed up any data that you may have as described in section 1.4.1.1 
in Chapter 1 of this document. 
 

(Q) Why does the Web Console tree not show up in my browser when I log 
in to the Jiffy Web Console? 
 

(A) Make sure that JavaScript is enabled in your browser. The Jiffy Web Console 
depends on JavaScript to be fully functional.  
 

(Q) Sometimes while using the Jiffy Web Console, I do not get the expected 
response when I make a request, why? 
 

 (A) Some requests you make while using the Jiffy Web Console require popup 
windows in order to mimic the functionality of a standalone application’s 
Graphical User Interface (GUI). So, make sure that you do not have a popup 
blocker installed in your web browser. If you already have one and would like to 
keep it, temporarily disable popup window blocking when you want to use the 
Jiffy Web Console. 
 

 
 
 


